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ProClarity Corporation

END-USER LICENSE AGREEMENT FOR 

PROCLARITY CORPORATION
IMPORTANT-READ CAREFULLY: This ProClarity Corporation
("ProClarity") End-User License Agreement ("EULA") is a legal agreement
between you (either an individual or a single entity) and ProClarity for the
software product identified above, which includes computer software and
associated media and printed materials, and may include "online" or electronic
documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By installing,
copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound
by the terms of this EULA. IF YOU DO NOT AGREE TO THE TERMS OF
THIS EULA, PROMPTLY RETURN THE UNUSED SOFTWARE PRODUCT
TO THE PLACE FROM WHICH YOU OBTAINED IT FOR A FULL
REFUND.

Software Product License

The SOFTWARE PRODUCT is protected by copyright laws and international
copyright treaties, as well as other intellectual property laws and treaties. (U.S.
Patent No. 6,167,396) The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.
This EULA grants you the following rights:

Systems software. You may install and use one copy of the SOFTWARE
PRODUCT on a single computer.

Storage/ Network Use. You may also store or install a copy of the SOFTWARE
PRODUCT on a storage device, such as a network server, used only to install or
run the SOFTWARE PRODUCT on your other computers over an internal
network; however, you must acquire and dedicate a license for each separate
computer on which the SOFTWARE PRODUCT is installed or run from the
storage device. A license for the SOFTWARE PRODUCT may not be shared or
used concurrently on different computers.

License Pak. If you have acquired this EULA as part of a ProClarity License Pak,
you may make the number of additional copies of the computer software portion
iii



ProClarity Desktop Client
of the SOFTWARE PRODUCT authorized on the printed copy of this EULA,
and you may use each copy in the manner specified above.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
Limitations on Reverse Engineering, Decompilation, and Disassembly. You may
not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT,
except and only to the extent that such activity is expressly permitted by
applicable law notwithstanding this limitation.

Separation of components. The SOFTWARE PRODUCT is licensed as a single
product. Its component parts may not be separated for use on more than one
computer.

Use Restriction. You may not commercially host, rent, or lease the SOFTWARE
PRODUCT, or otherwise provide fee-based use of, or access to any functionality
of, the SOFTWARE PRODUCT.

Software Transfer. You may permanently transfer all of your rights under this
EULA, provided you retain no copies, you transfer all of the SOFTWARE
PRODUCT (including all component parts, the media and printed materials, any
upgrades, this EULA and, if applicable, the Certificate of Authenticity), and the
recipient agrees to the terms of this EULA. If the SOFTWARE PRODUCT is an
upgrade, any transfer must include all prior versions of the SOFTWARE
PRODUCT.

Termination. Without prejudice to any other rights, ProClarity may terminate this
EULA if you fail to comply with the terms and conditions of the EULA. In such
an event, you must destroy all copies of the SOFTWARE PRODUCT and all of
its component parts.

3. UPGRADES.
If the SOFTWARE PRODUCT is an upgrade from another product, whether
from ProClarity or another supplier, you may use or transfer the SOFTWARE
PRODUCT only in conjunction with that upgraded product, unless you destroy
the upgraded product. If the SOFTWARE PRODUCT is an upgrade of a
ProClarity product, you now may use that upgraded product only in accordance
with this EULA. If the SOFTWARE PRODUCT is an upgrade of a component of
a package of software programs that you licensed as a single product, the
SOFTWARE PRODUCT may be used and transferred only as part of that single
product package and may not be separated for use on more than one computer.
iv
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4. COPYRIGHT.
All title and copyrights in and to the SOFTWARE PRODUCT (including but not
limited to any images, photographs, animations, video, audio, music, text, and
"applets," incorporated into the SOFTWARE PRODUCT), the accompanying
printed materials, and any copies of the SOFTWARE PRODUCT, are owned by
ProClarity or its suppliers. The SOFTWARE PRODUCT is protected by
copyright laws and international treaty provisions. Therefore, you must treat the
SOFTWARE PRODUCT like any other copyrighted material except that you
may either (a) make one copy of the SOFTWARE PRODUCT solely for backup
or archival purposes, or (b) install the SOFTWARE PRODUCT on a single
computer provided you keep the original solely for backup or archival purposes.
You may not copy the printed materials accompanying the SOFTWARE
PRODUCT.

5. U.S. GOVERNMENT RESTRICTED RIGHTS.
The SOFTWARE PRODUCT and documentation are provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is
subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data Computer Software clause at DFARS 252.227-7013 or
subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted
rights at 48 CFR 52.227-19, as applicable. Manufacturer is ProClarity
Corporation/P.O. Box 8064/Boise, ID 83707.

6. EXPORT CONTROLS.
You agree not to, directly or indirectly, export or re-export the SOFTWARE
PRODUCT without the appropriate United States or foreign government
licenses. The SOFTWARE PRODUCT is specifically subject to the U.S. Export
Administration Regulations.

MISCELLANEOUS
If you acquired this product in the United States, this EULA is governed by the
laws of the State of Idaho.

If this product was acquired outside the United States, then local law may apply.

Should you have any questions concerning this EULA, or if you desire to contact
ProClarity for any reason, please contact the ProClarity subsidiary serving your
country, or write: ProClarity Corporation Sales Information Center/ P.O. Box
8064/Boise, ID 83707.
v
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LIMITED WARRANTY
LIMITED WARRANTY. ProClarity warrants that (a) the SOFTWARE
PRODUCTS will perform substantially in accordance with the accompanying
written materials for a period of ninety (90) days from the date of receipt, and (b)
the media containing the SOFTWARE PRODUCT will be free from defects in
materials and workmanship under minimal use and service for a period of one (1)
year from the date of receipt. Some states and jurisdictions do not allow
limitations or duration of an implied warranty, so the above limitation may not
apply to you. To the extent allowed by applicable law, implied warranties on the
SOFTWARE PRODUCT and media, if any, are limited to ninety (90) days and
one year respectively.

CUSTOMER REMEDIES. ProClarity’s and its suppliers' sole and exclusive
obligation, and your exclusive remedy in the event of a breach of the terms of this
Limited Warranty, shall be, at ProClarity’s option, either (a) refund of the license
fee paid, or (b) repair or replacement of nonconforming SOFTWARE
PRODUCTS accompanied by a copy of your receipt. This Limited Warranty is
void if failure of the SOFTWARE PRODUCT or media has resulted from
accident, abuse, modification, or misapplication. Any replacement SOFTWARE
PRODUCT or media will be warranted for the remainder of the original warranty
period or thirty (30) days, whichever is longer. Outside the United States, neither
these remedies nor any product support services offered by ProClarity are
available without proof of purchase from an authorized international source.

NO OTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, PROCLARITY AND ITS SUPPLIERS DISCLAIM
ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
WITH REGARD TO THE SOFTWARE PRODUCT, AND ANY
ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH
VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
PROCLARITY OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS)
vi
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ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE
PRODUCT, EVEN IF PROCLARITY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES AND
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATIONS
OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.
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ProClarity Desktop Client Documentation
Whether you are a first-time ProClarity Desktop Client user or a seasoned
operator wanting to increase your skills, you can find the help you need from
the ProClarity Desktop Client documentation set. The following documents
provide complete information about working with ProClarity Desktop Client
as a stand-alone application and as part of ProClarity Enterprise Server
(ProClarity Server):

• The Getting Started Guide—to help new users or to refresh basic skills.
• ProClarity Desktop Client Online Help—to provide immediate help with

using any Desktop Client function.
• MDX Help—to help users understand how to use the MDX Editor to build

customized MDX queries.
• ProClarity Server Authoring Tool Online Help—to help briefing book

authors publish books to libraries on the ProClarity Server where those
books can be accessed through a Web browser by other authorized users.

• The Developer’s Guide—to help developers customize their applications
with the ProClarity Desktop Client Object Model.

• The Administrator’s Guide—to provide information about deploying
Active Books™.

Getting Started Guide
The Getting Started Guide is intended for new ProClarity Desktop Client
users or those who use the application infrequently and need a refresher in
the basics. It includes information about the following:

• Installing and starting ProClarity Desktop Client
• The basics of multidimensional analysis
• Using basic data query techniques to answer specific questions
• Exploring your data
• Saving and communicating views
• Online Publishing
• Using advanced functions

About feature availability

The Getting Started Guide provides information about the features that are
available while using ProClarity Desktop Client with ProClarity Server. If
you are using a different version of ProClarity software, some of the features
described in the guide may not be available. The other versions are as
follows:

For information 

about ProClarity 

Enterprise Server, 

see Chapter 7.
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• ProClarity Desktop Client only (without ProClarity Server). All of the
features described in this Guide except for those provided by the
ProClarity Server Authoring Tool are available.

• ProClarity Rich Client. The Rich Client has the look and feel of ProClarity
Desktop Client but runs in a Web browser. You can publish to ProClarity
Server from the Rich Client. However, because briefing book publishing
properties are honored, some features may not be available in some
briefing books that are used within the Rich Client.

• ProClarity Active Books. Because briefing book publishing properties are
honored, some features may not be available in some Active Books. Also,
an Active Book may be read-only and provide no analysis features.

ProClarity Desktop Client Online Help
You can access immediate help for any task you want to accomplish by
using the Online Help. Online Help provides step-by-step instructions for
each of ProClarity Desktop Client’s data analysis tools. It also provides an
overview of multidimensional analysis and explains how to access other
help and product support information. In addition, most of the Desktop
Client dialog boxes have a Help button, and most fields have tips.

To access Online Help: From the menu bar, click Help and select Contents.

MDX Help
The online MDX Help provides information to those who want to customize
queries using the MDX language. To access MDX Help, from ProClarity's
View menu, select MDX Editor. Then, click the Help button.

ProClarity Server Authoring Tool Online Help
The ProClarity Server Authoring Tool Online Help provides information
about how to retrieve briefing books from and publish books to the
ProClarity Server. This help also describes how to organize libraries on the
ProClarity Server and how to manage security for the briefing books you
publish. To access the Authoring Tool help, from the Desktop Client toolbar,
click the ProClarity Server button. Then, click Help.

Developer’s Guide
The online Developer’s Guide provides information about the use of
ProClarity Desktop Client Object Models for various development
scenarios. To access the Developer’s Guide, from the menu bar, click Help
and select ProClarity Desktop Client Developer’s Guide.

Briefing books and 

publishing 

properties are 

explained in Chapter 

6. ProClarity Server 

and Active Books 

are explained in 

Chapter 7.

For information 

about ProClarity 

Server, see Chapter 

7.
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Administrator’s Guide
This online document provides information about deploying ProClarity
Desktop Client Active Books. The Client Installation screen provides an
option to view this guide, or you can browse the ProClarity Desktop Client
application CD to find AdminInstall.txt.

ProClarity Enterprise Server Documentation
In addition to the ProClarity Desktop Client documentation, the ProClarity
product family contains documentation for users of other components of the
ProClarity Enterprise Server. The following table identifies those users and
the available documentation:

ProClarity Product Support
All users can obtain technical support by viewing the FAQs on the
ProClarity Corporation Web site.

Users with a ProClarity support and maintenance subscription will have
access to the following additional benefits:

User Documentation Description

Web Client 

Users

Web Client Online Help Provides instructions for accessing briefing 

books and analyzing the data in those 

briefing books through a Web browser.

Web Client Quick Start Guide A four-page card provides “quick start” 

information about menu and toolbar 

contents and instructions for applying basic 

analysis features.

Administrators Server Administrator’s Guide Provides instructions for installing, 

configuring, and deploying ProClarity 

Enterprise Server.

Administration Tool Online 

Help

Provides instructions for using the 

Administration Tool (MMC snap-in) to 

administer servers, assign users, and 

manage security roles. 

Developers ProClarity Enterprise Server

Developer’s Guide

Provides information for developing three-

tier business analysis solutions using the 

ProClarity Analytic Platform™ Enterprise 

Edition Developer's Kit.
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• 24 hour online support
• Help desk support for up to 2 designated customer contacts

- M-F, 7am - 6 pm MST from our US headquarters, excluding major US
holidays

- M-F 8am - 5pm in our European headquarters
• Licensed product upgrades and maintenance releases shipped automati-

cally

If you have questions about your existing support subscription or would like
to purchase a new one, contact your ProClarity Corporation sales
representative at (208) 344-1630 or sales@proclarity.com.

To obtain the FAQs and other support, open the ProClarity Corporation Web
site at www.proclarity.com.

What's New in Version 4.0
The primary addition to Version 4.0 of the ProClarity Desktop Client is the
briefing book Authoring Tool, which is available if you are working within
the ProClarity Server environment. Features associated with the Authoring
Tool are as follows:

• Publish a briefing book to ProClarity Server. Deploying briefing books
within the ProClarity Server environment is simplified because briefing
books are saved to a common server, and readers need only a Web
browser to access the briefing books.

• Manage ProClarity Server briefing books. The Authoring Tool allows you
to manage security for the briefing books you publish.

• Retrieve ProClarity Server briefing books. You can open books from Pro-
Clarity Server and analyze them using Desktop Client features. You can
also edit them and save them to your computer or (if access privileges
allow) republish them to ProClarity Server.

The following are additional features or changes for the ProClarity Desktop
Client 4.0:

• Use Cube Cell Formatting Properties. This is available from the Grid
Configurations Options box. If selected, queries will return cell properties

For information 

about ProClarity 

Server, see Chapter 

7.
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(such as background color and font style) that have been set in the
database. See page 57.

• Use Non-Empty Crossjoin. This is available from the Options box. (From
the File menu, select Options). When selected, the MDX Non-Empty
Crossjoin function is used during query execution.

• "Children" member in the dimension tree (drill-down feature). See
page 36.

• Rotate Axis Labels. You can change vertical labels to horizontal ones and
vice-versa. See page 61.

• Show All Column Header Text. This can be selected in the Column
Header tab of the Grid Configurations Options box (see “Changing grid
properties” on page 57). If selected, column widths are based on the length
of the column header. If not selected, column widths are based on the
longest number in a column.

• Number of items found. The Find feature (see “Finding dimension
members” on page 27) now displays the number of items found.

• Insert a level into a Decomposition Tree. See “Working with the Decom-
position Tree” on page 66.

To learn more about recently added features, see the ProClarity Desktop
Client Online Help.
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Chapter 1: Understanding ProClarity Desktop Client
Chapter 1: Understanding ProClarity 

Desktop Client and Multidimensional 

Analysis
This chapter explains how ProClarity™ Desktop Client provides
the tools you need to create useful, visual information from your
business data. The chapter also provides a foundation for
effectively using these tools by explaining the concepts of Online
Analytical Processing (OLAP) and Multidimensional Analysis.

The data problem
Many decision-makers “drown in data while thirsting for
information.” You probably have no lack of data—income
statements, balance sheets, sales figures, production figures,
quarterly reports, annual reports—the list is long. While these
standard reports give you a great deal of data, they do not always
provide the information you need about your business.

Turning data into information
Data + Relevance + Context = Information

By itself, data does not provide information. To create information
from data, you must first sort through the available data to extract
the specific data points (individual facts) that are relevant to
answering the questions you have in mind.

Next, you must arrange the relevant data into the desired context of
relationships. The magnitude of a data point by itself is of little
importance. What is important, however, is whether the magnitude
of that data point is what it should be relative to the same period last
year, to its peers, and to the overall trend. For example, if the
company had $1 million in sales this year, you would compare this
figure to last year’s sales and to the overall growth trend of the
company. These kinds of relationships among the data reveal cause
and effect patterns, trends, and exceptions that indicate how your
business is doing and where it is going—information you can use to
make decisions.
1
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Only after the relevant data is arranged within a context of relationships can
you derive information from the data and make decisions based on the
information.

Getting stuck in the report cycle
Sorting though paper reports to extract the relevant data and put it into the
desired context can be overwhelmingly cumbersome. Sending report
requests to your data department to arrange the specific data the way you
want it can produce delays that make the reports obsolete. Then, viewing a
custom report generates more questions in your mind, and these questions
generate more report requests that produce further delays.

There must be a better way.

The ProClarity Desktop Client solution
There is a better way.

ProClarity Desktop Client is a multidimensional analysis software package
that allows you to interact directly with the data on your server. Using
familiar click-and-drag techniques and drop-down menus, you can query
your database to extract the data you deem relevant and arrange it in the
context you deem useful to create information in a matter of minutes. And
the information can be presented as graphs or charts, so you can easily see
the data relationships.

With ProClarity Desktop Client, if the result of one query generates another
question in your mind, you can instantly find the answer. By rearranging the
data, choosing a different set of data, and exploring various levels of detail in
the data, you can view successive relationships as you follow a train of
thought.

What are OLAP and multidimensional 

analysis?
Online Analytical Processing or OLAP is a way of analyzing data by
interacting directly with data rather than by reviewing static paper reports.
OLAP technology arranges raw data so that someone working at a computer
can view the data in graphic formats that reflect a wide variety of
relationships among the data. OLAP makes multidimensional analysis
possible.
2



Chapter 1: Understanding ProClarity Desktop Client
Multidimensional analysis is a process of analyzing data that is organized
according to the variables (such as region, product, time, etc.) that decision-
makers find most useful in looking at their businesses.

For example, let’s assume you have data regarding sales dollars. You also
have data regarding which products and regions generated the sales dollars
over various periods of time. The quantitative measure (sales dollars)
contains dimensions—product, region, and time.

When you view sales, you want to see how sales were related to the products
that generated them. Perhaps you want to limit your product comparisons to
only the top ten sellers. Then, you want to see how the sales per product
fluctuated over time. Also, you want to see how the sales per product during
a certain time period compared among regions. In other words, you want to
see how the various dimensions of the data relate to one another.

Information derived from relationships among data dimensions fosters
decision-making. This is what multidimensional analysis is all about.

Terms used in multidimensional analysis
Data is stored on the server’s database in a multidimensional arrangement
referred to as a cube. Cubes contain measures and dimensions of measures.
Measures are quantitative values. Some examples of measures are Sales
Dollars, Number of Product Failures, Gross Margin, and Average Inventory
Levels. While all cubes have at least one measure, they can have multiple
measures.

Measures are analyzed by dimensions (attributes or categories). For
example, you can analyze the measure Sales Dollars by Geographic Region
or Product Family.

Dimensions are organized into a hierarchical tree. Components of the
dimension are referred to as members or items.

The sample cube that follows for a hypothetical computer manufacturer
illustrates dimensions and their members organized in a hierarchical tree.
3
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Example of dimensions and their members in a hierarchical tree

• The cube contains one measure: Sales.
• The cube contains three dimensions: Products, Geographic Region, and

Time.
• Among the items that are members of dimensions are All Products,

Europe, and July.

When you use ProClarity Desktop Client, you access a cube and choose
relevant data by selecting measures and dimension members. You can
arrange the measures and dimension members in various layouts. The
arrangements create visual graphs and charts that illustrate relationships.
You can view relationships among members that are lower or higher in the
hierarchy by drilling down or drilling up. You can also filter and sort the
data. ProClarity Desktop Client offers these and many other tools so you can
choose relevant data and view it in pertinent relationships. ProClarity
Desktop Client lets you create the information you need to make decisions
about your business.
4
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Understanding Rows, Columns, and 
Background
When you create a chart or graph in ProClarity Desktop Client, you select
measures and dimension members to define the set of relevant data. A screen
displaying a chart of graph is called a “view.” You also arrange the measures
and dimension members into Rows, Columns, or Background to visualize
comparisons. The following example view illustrates a set of relevant data
and its arrangement.

Relevant data and its arrangement

Notice how the dimensions and their members specified as being Rows and
Columns relate to the row and column labels of the chart and the grid. Notice
also how the chart values correspond to the cell values of the grid.

How the relevant data and its arrangement affect your 

charts and graphs

Both the data that is selected and the way it is arranged affect the display.

The relevant data

In the two views that follow, the row, column, and background dimension
arrangements are the same, but the members included for each dimension are
not. View #1 includes all members of the Products dimension; View #2
includes only the Food member of the Products dimension.

A screen 

displaying a chart 

or graph is called a 

“view.”

Rows Columns

Rows

Legend

The view is 

displaying the 

Dimensions tool, 

which is used to 

select and arrange 

the data. The 

Dimensions tool is 

explained in 

Chapter 3.
5



Chapter 1: Understanding ProClarity Desktop Client
View #1: Includes the “All” member of the Products dimension

View #2: Includes only the “Food” member of the Products 

dimension

Because the relevant data for the two views is different, the values are also
different, even though the dimension arrangement is the same.

The data arrangement

In the two views that follow, the relevant data is the same, but the
arrangements are different. Both views include the same members of all
6
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dimensions, but the dimensions are arranged differently among the Rows,
Columns, and Background.

Because the relevant data for the two views is the same, the values are the
same, even though the dimension arrangements are different.

Different arrangements emphasize different comparisons. View #1
emphasizes a state-to-state customer comparison; View #2 emphasizes a
quarter-to-quarter comparison.

View #1: Displays the Time dimension in Rows, the Customer 

dimension in Columns
7
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View #2: Displays the Customer dimension in Rows, the Time 

dimension in Columns

The Background

Items in the Background are not being visually compared in the displayed
graph. However, they are affecting the relevant data. Changing Background
member selections, which changes the relevant data, allows you to view
different data "slices." In other words, the Rows and Columns comparisons
are based on different data subsets as defined by the selected Background
members.

In the following examples, note how a change made to an item selected in
the Background (the F or M members of the Gender dimension) affects the
chart values.
8
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Some restrictions apply to Background items as follows:

• If you drill down or drill up on a Background dimension, the dimension
will automatically move to the Rows.

• For any dimension in the Background, only one member may be used at a
time.

The application allows you to select more than one member at a time on a
Background dimension. You must then decide how to use them one at a
time. Making multiple selections on a Background item is explained in the
Dimensions tool section of Chapter 3.

F member selected in the 

Background Gender dimension

M member selected in the 

Background Gender dimension
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ProClarity Desktop Client screen details
The following explains ProClarity Desktop Client screen areas.

Status 

bar

Row 

label

Column 

labels

View 

title

Menu bar

Chart title

Toolbar

Row legend

Enables briefing 

book page 

editing

Toggles a 

notes area

Details of the ProClarity Screen

ProClarity Server button 

(the “Authoring Tool”)
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Chapter 2: Installing and Starting ProClarity 

Desktop Client
This chapter includes the system requirements and instructions for installing,
starting, and exiting ProClarity Desktop Client. It also includes instructions
for moving among data views.

System requirements
Hardware

Pentium class processor

80MB RAM minimum

(128MB RAM recommended)

Software

Windows® 95b or newer

OR

Windows NT 4.0 with Service Pack 5 or greater

OR

Windows 98

OR

Windows 2000

OR

Windows Me

Microsoft® Internet Explorer 5.0 or greater

Installing ProClarity Desktop Client
The ProClarity Desktop Client installation program leads you through a
series of screens. Follow the instructions on the screens to specify which
components to install and to specify the folder in which the components will
reside. The default program folder is C:\Program Files\ProClarity\ProClarity
Desktop Client.
11
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Before installing ProClarity Desktop Client 4.0, please do the following:

• Exit all other software programs.
• If an earlier version of ProClarity Desktop Client is currently installed,

uninstall it before installing ProClarity Desktop Client 4.0.
• If your computer does not have Microsoft Windows Installer already

loaded, the ProClarity Desktop Client Installation program will install it
automatically. This will require you to restart the system before proceed-
ing with the rest of the ProClarity Desktop Client installation process.

1. Insert the ProClarity Analytic Platform CD-ROM into the computer
CD-ROM drive. After a few seconds, the first ProClarity™ Analytic
Platform 4.0 Desktop Edition Installation screen appears.

2. Click Install ProClarity.

3. At the Welcome screen, click Next. The License Agreement screen
appears.

4. Read the License Agreement and select the option for accepting the terms
of the license, then click Next. If you do not accept the terms, the
installation program will discontinue the process. When you accept the
terms and click Next, the Customer Information screen appears.

5. Complete the screen information and click Next. The Custom Setup
screen appears.

Note

If the computer does not automatically start the installation program after the CD has been 

loaded, do the following:

• From the Windows Start menu, select Run.

• Click Browse to locate Install.exe on the CD.

• Double-click Install.exe. The Install.exe path will appear in the Run box.

• Click OK. The ProClarity Desktop Edition Installation screen appears.

• Click Install ProClarity Desktop Client to begin choosing installation options.

Note

If ProClarity Desktop Client 4.0 is currently installed, the Program Maintenance screen will 

appear, giving you the option to Modify, Repair, or Remove the program files. Select an option 

and click Next.
12
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6. To accept the default installation options, click Next on the Custom
Setup screen or use the Custom Setup screen to decide the components
you wish to install, where you want the files located, the amount of disk
space you have available, and whether to include Other Files with the
installation. When using this screen, note the following:

• The Feature Description window briefly identifies the purpose of the
highlighted component and the amount of disk space required to install
the corresponding files.

• The Microsoft Office Integration component provides files that allow
ProClarity Desktop Client to work interactively with Microsoft Office
2000 products if Office 2000 is currently installed.

• The ProClarity Samples component provides various files to help the
user work with and learn the more advanced features of ProClarity™
Desktop Client.

• The Connection to ProClarity Enterprise Server allows users to
publish, manage, and retrieve ProClarity Server briefing books.

• The Change button allows you to choose where to install the program
files.

• The Space button displays the amount of disk space that is available on
the system’s hard drives.

• To select or deselect components other than the default selections, click
on the box next to the component and choose an option from the drop-
down menu.

7. After choosing the setup options, click Next.

8. The Ready to Install the Program screen lets you review or change any
of your installation settings. Click Install to continue with the installation.

9. When the InstallShield Wizard Completed screen appears, you can click
the View Readme button to display a Readme file. The Readme file
contains information about the new ProClarity Analytic Platform features,
a list of CD contents, product support contact information, system
requirements, and known technical issues with the program.

10.Click Finish to complete the installation.
13
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The initial installation screen reappears. When viewing the screen, note the
following:

• The Online Registration button takes you to ProClarity’s online
registration form.

• The View ReadMe.txt button displays the readme file.
• The View Administrator’s Guide displays the Active Book

Administrator’s Guide.
• The Browse CD contents button opens a Windows Explorer screen

containing the folders and files on the CD.
• The www.proclarity.com button takes you to the ProClarity

Corporation Web site.
• The Contact Us button provides ProClarity Corporation contact

information.

Starting ProClarity Desktop Client
1. On the Windows Desktop, double-click on the ProClarity Desktop

Client 4.0 icon.

OR

From the Windows Start menu, point to Programs, then select:
ProClarity>ProClarity Desktop Client>ProClarity Desktop Client
4.0.

Depending on how your system is configured, the following may happen
when you start ProClarity Desktop Client:

• A briefing book opens.
• A home page is displayed.
• The Welcome screen with log on choices appears.
14
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The following figure illustrates the Welcome screen:

2. Select an option, then click OK.
Further steps depend on what you select.

• ProClarity Desktop Client Web Site: After viewing the Web site,
close the Web screen to return to the Welcome screen and select another
option.

• ProClarity Enterprise Server: The ProClarity Enterprise Server
box appears with options for accessing the ProClarity Server and
retrieving a briefing book. Perform the steps in the ProClarity
Enterprise Server Option section below.

• Cube for browsing: The Connect box appears with options for
connecting to an OLAP Server or a local cube. Perform the steps in the
Cube for browsing option section below.

• Local briefing book: An Open ProClarity Briefing Book box
appears. Locate and open the briefing book. The briefing book opens
and you are ready to begin.

ProClarity 

Enterprise Server 

(ProClarity Server) 

is explained in 

Chapter 7.

A local briefing book 

is a briefing book 

that is saved on 

your computer.
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• Briefing book from ProClarity Enterprise Server: Select a
previously opened briefing book from the bottom pane and click OK.
The briefing book opens and you are ready to begin.

ProClarity Enterprise Server option

The ProClarity Server box. This appears if you select ProClarity 

Enterprise Server.

1. Enter the name of the server URL.

OR

If the server requires a username and password, enter the name of the
server URL, click Security, and enter your username and password.

2. Click OK to log on. The Retrieve Book screen appears.

The Retrieve Book screen

ProClarity Enterprise 

Server is explained 

in Chapter 7.
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3. Select a library from the libraries list in the left pane and a book from the
library contents list in the right pane.

4. Click OK. The selected briefing book is displayed.

Cube for browsing option

The Connect box. This appears if you select Cube for browsing

1. Select an option and fill in the fields as follows:

• Server: Enter the server name that contains the data you will analyze, or
click to select the server from a list of recently used servers.

To browse for a server, click the Find Server button. Windows NT 4.0
or Windows 2000 users: A Network Browse screen shows a list of net-
work servers and indicates which ones are OLAP servers. Other users:
The server may be listed in your Network Neighborhood.

• Local Cube: Enter the name of a cube located on a local disk. To
browse for a local cube, click the Browse button.

This option is available if you have the Microsoft OLE DB Provider for
OLAP Services. After a local cube has been created, you can open it
without being connected to the OLAP server and perform most ProClar-
ity Desktop Client functions with it. For more information about local
cubes, refer to Online Help.
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2. Click OK. The Open Cube window appears.

The Open Cube window

3. In the left pane, select a database from the list, and in the right pane, select
a cube from the list.

4. Click OK. A box listing view types appears.

View Type selection box
18
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5. Select an opening view type. The cube opens and is displayed in the
selected view.

If you want a cube to always open in a specific view, check Use as default
view before selecting a view type. Once you set a default view, all cubes will
open in that view until you turn off the default view. To turn off the opening
default view do the following:

1. From the File menu, select Options.

2. Click on the Other tab.

3. Clear the Use the current default view box.

4. Click OK.

The next time you open a cube, you will be able to select a different opening
view.

Changing the OLAP Provider
Your OLAP Provider is your Online Analytical Processing (OLAP) server
software. Microsoft OLE DB Provider for OLAP Services 8.0 is an example.

To change providers, do the following:

1. From the File menu, select Options.

2. Click the OLAP Provider tab and click Select a new provider.

3. After selecting a new provider, click OK, and the Connect screen will
appear.

When you start subsequent sessions, ProClarity Desktop Client will default
to the last provider used.

Connecting to a different server and cube
1. From the File menu, select Open Cube. The Open Cube dialog box

appears.

2. To connect to a different server, click the Connect button.
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3. In the Connect box, select a server or a local cube file.

4. Click on the type of view you want to use.

The ProClarity Desktop Client toolbar
The toolbar provides quick access to several of ProClarity Desktop Client’s
frequently used features. The following lists the available toolbar buttons
and describes the purpose of each.

Wizard – Opens the Ad Hoc Query Wizard.

Book – Displays a list of current briefing book pages.

Decomp – Opens the Decomposition Tree Wizard.

Dimensions – Displays the Dimensions tool.

Drill Down – The button and down arrow display lists for drilling down on the
displayed data.

Drill Up – The button and down arrow display lists for drilling up on the
displayed data.

Page Edit – Allows you to edit a briefing book page.

English Query – Displays the English Query box that allows you to use text in
English to query the data.

Execute – Performs a query when Auto-Execute is turned off.

Favorites – Displays a list of favorite views.

Filter – Displays the Filtering box.

Notes – Toggles a section of the screen in which to type notes.

Forward – Goes to the next view (enabled if you have moved backwards). The
down arrow beside the button displays a list of previous views.

Back – Returns to the previous view. The down arrow beside the button
displays a list of preceding views.
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Customizing the toolbar
The ProClarity Desktop Client toolbar can be customized to display the tool
buttons that you use most frequently. You can also display or hide the button
names.

1. From the View menu, point to Toolbar and select Customize. The
Customize Toolbar box appears.

Customize Toolbar box

2. Scroll through the list of Available toolbar buttons or Current toolbar
buttons and select a button. Click Add to add a highlighted button to the
toolbar, or click Remove to delete a highlighted button from the toolbar.

Reset – Restores the current view to the default setting.

Sort – Displays the Sorting box for arranging the data in a specified order.

Timeline – Displays the timeline, which is used as a shortcut to vary the Time
dimension.

View – Changes the type of views displayed. The down arrow beside the
button opens a menu of view choices.

ProClarity Server - Allows users to publish, manage, and retrieve ProClarity
Server briefing books. The down arrow beside the button opens a menu.
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3. To rearrange the order of the buttons displayed on the toolbar, highlight a
button in the Current toolbar buttons list and click either the Move Up
or Move Down button until the toolbar button is in the position you want.
The toolbar buttons will be displayed onscreen from left to right based on
the top-to-bottom sequence in the list.

4. To display, reposition, or hide text labels from the toolbar, select an option
from the Text options drop-down menu.

Moving among saved or current session views
When you move to a view, the view is displayed on the screen and becomes
the current view. You can use the following to move among views:

Exiting ProClarity Desktop Client
To exit ProClarity Desktop Client, from the File menu, select Exit.

Button
Menu 

command
Task

(No menu 

command)

Move back or forward 

through views you 

have opened in this 

session.

From the 

Favorites menu, 

select Show 

Favorites.

Display a list of views 

you have saved as 

favorites. Select a 

view from the list to 

access the view.

From the Book 

menu, select 

Show Book.

Display a list of pages 

you have saved in a 

briefing book. Select a 

page from the list to 

access the view.
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Chapter 3: Using Basic Data Query 

Techniques
This chapter is designed to get you started with data analysis by explaining
how to create a chart or grid view using one of ProClarity Desktop Client’s
data analysis wizards—the Ad Hoc Query Wizard. It also explains how to
use the Dimensions tool to select and arrange measures and dimensions.

About the Ad Hoc Query Wizard
Questions you have about specific data relationships are ad hoc questions.
Some examples are: “How did the combined sales figures among each of my
stores compare during last year?” or “How did the combined sales figures
from all of my stores compare in each quarter of last year?” To find the
answers, you can query (formulate a question to) the database. The Ad Hoc
Query Wizard makes it easy to do this.

Using the Ad Hoc Query Wizard

To start the Ad Hoc Query Wizard, click the Wizard button.

On each screen, make selections to specify the measures and dimension
members you want to include. To progress to the next screen, click Next. To
change a selection from a previous screen, click Back. On the final screen,
specify the arrangement you want, then click Finish to run the query. The
result of the query is a view based on the measures, dimension members, and
arrangement you have specified.

Each screen of the Ad Hoc Query Wizard provides the instruction needed for
that screen. Also, each screen provides a Help button.

The following sections provide further explanation for the Time Value
options and the Find feature.

Ad Hoc Query 

Wizard button
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Using the Time Value options
The Time dimension screen offers time value options as follows:

• Period Value—The actual value stored in the cube for the selected
dimension members.

• Year-to-date Value—The sum of all periods since the start of the year.
• Rolling Period Value—The sum of values for the previous number of

designated periods. For example, if you select a Rolling 3-Period Value
with June selected as the month, the value displayed for June is the sum of
the values for April, May, and June.

The Find feature
Each Dimension screen (except the Time dimension) offers a Find feature
for finding members that belong to the dimension. For example, on the
Product Dimension screen, you could find all members that contain the word
“Beverages.”

To use the find feature, see the “Finding Dimension Members” section later
in this chapter (page 27).

Using the Dimensions Tool
Using the Dimensions tool, you can select the specific items you want to
analyze and specify their arrangement. The result of your selections is then
reflected graphically in the view when you execute the query.

Executing a Query (refreshing a view)
When you use the Dimensions tool, you create a query. The query must be
sent to the cube (or executed) to retrieve the requested data. The view is then
“refreshed” to show the result of the query.

Note
By selecting Rolling Period Value or Year-to-date Value, you create a calculated measure 

(not supported by all OLE DB for OLAP providers). To learn more about calculated measures, 

see Chapter 8.
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Queries can be executed in the following two ways:

• Auto Execute: The query executes and the view refreshes when you move
the mouse cursor over the view. To enable the Auto Execute feature, from
the View menu, select Auto Execute.

• Manual Execute: The query executes and the view refreshes when you
click the Execute button. To manually refresh views, from the View
menu, clear the Auto Execute command.

Selecting measures and dimension members
To display the Dimensions tool, do one of the following:

• On the toolbar, click the Dimensions button.

OR

• From the View menu, select Dimensions.

The Dimensions tool

Execute

button

Dimensions

button

Dimension tabs

Dimension tree

Layout area
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The following explains how to select dimensions and measures using the
Dimensions tool:

• To select measures, click the Measures tab.
• To select members from a particular dimension, click a tab.
• To select multiple members, hold down the Ctrl key while selecting.
• To select a range of adjacent members, click and drag the mouse to select

the desired range.
• To select the descendents at a specific level, right-click on a member,

point to Select Descendents, then select a level.
• See the following explanation for making Background member selections.

Making multiple selections on a Background item

You can select multiple members of a Background item if you do one of the
following:

• Option 1: After selecting the Background members, execute the query.

When you execute the query, a box appears prompting you to choose an
option for handling multiple selections.

The first two options move the dimension but retain the selections. The
last option keeps the dimension in the Background but selects only one
member (for example, the “All” member).
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• Option 2: Before executing the query, “slice” the dimension. Right-click
on the selected members and select Slice Dimension. Doing this creates a
Slicer. The dimension name appears just under the title bar with a drop-
down list of the members you selected. From this list, you may select one
member, or one slice of data to display, at a time. Up to three dimensions
may be sliced at a time.

Two displayed Slicers

Displaying a sliced dimension creates special considerations for filtering and
sorting. Typically, you will display a slicer to use in a briefing book so that
the briefing book users can change dimension members without having to
use the Dimensions tool.

Finding dimension members
From a dimension tab, you can use the Find button to search for a member
of the dimension.

1. Click the Find button.
When the button is enabled, its appearance changes and the Find box
replaces the Dimension tree.

sliced Product dimension sliced Store Type dimension

Filtering and sorting 

are explained in 

Chapter 4. Briefing 

books are explained 

in Chapter 6.

Find 

button

enabled

Find button
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Find box replacing the Dimension tree

2. In the Find field, type in the name or partial name of the member you
want to find. For example, if you want to find all Product members that
include the word “Beverages,” type that word in the field.

3. Click Go.
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The search may take several seconds to complete. When finished, a list
appears of each member containing the words you entered and the member’s
place in the dimension hierarchy.

Find box search results for “Beverages”

4. From the list, select the items you want.

5. Click the enabled Find button to close the Find box and return to the
Dimension tree.

The tree is expanded and the specified dimension members are selected.

Hiding empty members
When using the Dimensions tool, you can hide dimension members that
contain no data. Hiding applies to all dimensions arranged within the same
section of the Dimensions tool.

For help with the 

Advanced Find 

feature, see 

ProClarity Desktop 

Client Online Help.

enabled

Find button
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1. On the Dimensions tool, click one of the Hide buttons to hide empty
members for the Rows, Columns, or Background dimensions.

The button changes to indicate that the Hide feature is enabled for that sec-
tion of the Dimensions tool, and empty members belonging to the dimen-
sions in that section are hidden in the Dimension tree.

2. Execute the query. Any empty members will be hidden from the view.

The Hide feature in the Dimensions tool affects filtering. For example, if you
click the Hide empty rows button, the Eliminate Empty rows box is
selected on the Filtering dialog box. Conversely, if you select Eliminate
Empty columns on the Filtering box, the Hide empty columns button is
selected on the Dimensions tool.

Turning off the Hide feature

To turn off the Hide feature so that empty members will display, do one of
the following:

• On the Dimensions tool, click the enabled Hide button, then execute the
query.

OR

• Right-click on the background of a chart or grid and select Filtering. In
the Filtering box, clear one or both of the Eliminate Empty check boxes.

Hide 

button

enabled

Hide button

Filtering is explained 

in Chapter 4.

enabled

Hide button
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Arranging the layout
Use the layout area of the Dimensions tool to move measures and
dimensions into Rows, Columns, and Background.

The layout area of the Dimensions tool

Keep the following in mind as you arrange the layout:

• Row and column items are creating visual relationships. Background data
is still relevant, but it is not graphically visible.

• You must have at least one item in each of the Rows and Columns areas.

Layout area

Tips
• To see more detail about an item in the layout area, point to the item. 

• If you double-click an item listed in the Rows, Columns, or Background areas, the 

corresponding dimension tab displays.
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Changing the display format for the 
Dimensions tool tabs

1. From the File menu, select Options.

2. Select Other.

• To display horizontal scrollable tabs, clear the Use cascading tabs in
Dimensions tool option.

• To display cascading tabs, select the option.
32
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Chapter 4: Using Charts and Grids to 

Explore Data
Frequently, a view that you create to answer one question will lead you to
ask other questions and probe other data relationships. For example, suppose
a view answers the question, “How did sales for my Northwest stores
compare over last year?” The same view may raise another question: “Store
#3 had the most sales last year. Was this true for each quarter?” The answer
to this question may make you wonder, “What products at Store #3
contributed to its success in the second quarter?” This process of one answer
(or view) leading to the next question, which leads to the next view, etc., is
involved in data exploration.

You could explore data using only the Dimensions tool (explained in
Chapter 3) to vary your data display. However, ProClarity Desktop Client
provides several other tools that simplify data exploration. Using these tools,
you can quickly rearrange (pivot) dimensions, display lower or higher levels
of data hierarchy (drill down, drill up, expand, and collapse), obtain a list of
transactions that make up value (drill to detail), and focus on select
dimension members (isolate and eliminate).

You can also explore data using various view types such as charts, grids, the
Decomposition Tree, and Perspective. Each type has features that allow you
to view comparisons, trends, and relative percentages among the data.

This chapter explains tools you will frequently use to explore data within the
chart and grid view types. These tools are not used in any particular order.
As one question leads to another, you use whatever tool is appropriate to the
question you have in mind at the time.

Obtaining a chart or grid view
Data views can be displayed in full-screen formats, or on a split-screen
containing a grid and one other format.
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Displaying a chart

1. On the View menu, point to Business Charts and then select a chart type.

OR

Click the down arrow beside the View button to display a drop-down
menu.

2. Point to Business Charts, then select a chart type to display the desired
chart view.

Choosing a chart type from the View menu

Displaying a grid

1. On the View menu, point to Grid, then select a grid display option.

OR

Click the down arrow to the right of the View button to display a drop-
down menu.

2. Point to Grid and select a grid display option.

Displaying a full-screen grid using the View button

View 

button

View 

button
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Displaying a chart and grid in a split-screen

1. Select a chart type from the Business Charts drop-down menu.

2. From the Grid drop-down menu, select Bottom or Right to display the
grid with a chart in the view.

Toggling between views
If you want to quickly switch view formats, click the View button. Each time
you click the button, the view changes to the next view option shown on the
Grid menu.

Drilling down
Drilling down enables you to see the comparisons among lower-level
members of a dimension’s hierarchy. Drilling down increases the amount of
detail being displayed.

For example, suppose you have a view comparing store sales of Drink, Food,
and Non-Consumable Products during a year. If you want to see
comparisons among Food items, you can drill down on the Food member.
The following two views illustrate the result.

View before drilling down

View 

button
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View after drilling down on “Food”

You can drill down in the following ways:

• Drill down directly on the chart or grid. This is the quickest way to drill
down on a single dimension member.

• Right-click on the chart to display a menu. Point to Drill Down and select
an option.

Drilling down directly on a chart or grid

1. Move the mouse cursor over a chart, the chart Rows legend, or a grid. The
cursor changes to a drill when you pass over an area representing
dimension members that you can drill down on.

2. Click on the area you want to drill down.

Tips

• To visualize the change in your dimension selections, before you drill down, display the 

Dimensions tool and click the tab for the dimension on which you will drill down. When 

you drill down, you will see the new member selections.

• When you drill down, the selected member in the Dimensions tool is “Children.” To see the 

members, right-click on Children and select Show Items.

drill down

cursor
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• On a chart, the first row item that is not already at its lowest level is
drilled down.

• On a grid, the row or column item you click is drilled down.

Using the right-click menu to drill down 

1. Move the cursor over a chart, the chart Rows legend, or a grid. The cursor
changes to a drill when you pass over an area that can be drilled. Right-
click an area and point to Drill down.

2. From the list, select the items you want to drill down.

• To drill down on a single item, select the item.
• To drill down on more than one item, click Select item(s) from list to

open the Drill down box. Then hold down the Ctrl key while selecting
items. Click OK to update the view.

• The right-click list includes Background dimensions. If you drill down
on a Background dimension, it automatically moves to the Rows and is
displayed in a drilled-down state—all members from the next-lower
level are selected and displayed.

Automatic switch to grid
During drill down on a chart, the query may return too much data for a chart
display. The following message will appear.

Click OK to see a grid view of the data.

Drilling up
Drilling up enables you to see the comparisons among higher-level members
of a dimension’s hierarchy. Drilling up decreases the level of detail being
displayed.

For example, suppose you have a view comparing sales for three months of a
quarter and you want to view the quarter data. You could drill up on any of
the months currently displayed. The following examples illustrate this.

drill down

cursor
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View before drilling up

View after drilling up on any of the months
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In order to drill up on a dimension, it must be in either the Rows or Columns.

You can drill up in the following ways:

• Hold down the Shift key and click directly on the chart or grid. This is the
quickest way to drill up on a single dimension member.

• Right-click on the chart to display a menu. Point to Drill Up and select an
option.

Drilling up directly on a chart or grid

1. Hold down the Shift key while moving the cursor over a chart, the chart
Rows legend, or a grid. The cursor changes to a drill with an up arrow
when you pass over an area representing dimensions members that you
can drill up on.

2. Continue holding down the Shift key, and click the member you want to
drill up on. The new view reflects your selection.

Using the right-click menu to drill up 

1. Move the cursor over a chart, the chart Rows legend, or a grid. The cursor
changes to a drill with an up arrow when you pass over an area that can be
drilled. Right-click an area and point to Drill Up.

2. From the list, select the items you want to drill up.

• To drill up on a single item, select the item.
• To drill up on more than one item, click Select item(s) from list to open

the Drill Up box. Then hold down the Ctrl key while selecting items.
Click OK. When you do, the view is updated.

Drilling To Detail
Drill To Detail allows you to obtain a list of individual transactions, or
records, that make up a value. To use Drill To Detail, the feature must be

Tip

To visualize the change in your dimension selections, before you drill up, display the 

Dimensions tool and click the tab for the dimension on which you will drill up. When you drill 

up, you will see the new member selections.

drill up

cursor

drill up

cursor
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enabled for the cube (see your cube administrator for more information
about enabling this feature).

1. Right-click on one of the following:

• A grid value.
• A chart series (bar or pie slice) or an item listed in the chart Rows

legend.
• A Decomposition Tree node.
• A Perspective data point.

2. Grid or Perspective: Select Drill To Detail.
Chart or Decomposition Tree: Point to Drill Down, then select Drill To
Detail.

Note

Before you use this feature, either drill down on an item to the lowest hierarchy level, or limit 

the number of records that will be retrieved. Otherwise, Drill To Detail may take a long time to 

complete. (For the procedure to restrict retrieved records, see “Limiting the Number of Records 

Retrieved” on page 41.)

For more information 

about the 

Decomposition Tree 

and Perspective tool, 

see Chapter 5.
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When Drill To Detail is finished, a list of records is displayed.

Details list for Drill to Detail

• To copy the list to the Clipboard, click the Copy button.

• To export the list to a Microsoft Excel spreadsheet, click the Export
button.

3. To return to the view, close the Details list.

Limiting the number of records retrieved

1. Right-click on the background of a chart, grid, Decomposition Tree, or
Perspective view and select Properties.

2. From the list on the left, click Drill To Detail.

3. Click Maximum records to Retrieve, then enter a number.

4. Click OK.

Using navigation features
While drill up and drill down are most easily accessed directly from a chart
or grid, these functions can also be accessed from the Navigate menu. The
Navigate menu also provides four other tools for exploring data:

For more information 

about the 

Decomposition Tree 

and Perspective tool, 

see Chapter 5.
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• Expand—allows you to drill down on one displayed member while
leaving the remaining members at their current hierarchy levels.

• Collapse—does just the opposite of expanding while leaving the
remaining members at their current hierarchy level.

• Isolate—allows you to focus your analysis on only a few members.
• Eliminate—is useful for removing a member that is skewing results or

members that are irrelevant to the view.

1. From the Navigate menu, point to the option you want.
A list appears.

2. Select a dimension member.

• To select a single member, click it.
• To select multiple members, click Select item(s) from list to open

another list. Hold down the Ctrl key while you select the members you
want, then click OK.

The new view will reflect your selections.

Pivoting dimensions
During data analysis you may want to change the arrangement of your data
to emphasize various relationships (see the “relevant data and its
arrangement” discussion on page 5). When you pivot a view, the Rows
dimensions switch to being in Columns, and the Columns dimensions switch
to being in Rows.

To pivot dimensions, do the following:

1. Right-click on the background of a chart or grid.

2. Click Pivot.

Using the timeline
To display the timeline, from the toolbar, click the Timeline button.

If there are multiple Time dimensions in the current cube, you will be given
a choice of which one to display in the timeline.

When the timeline is visible, you can use it to isolate a time period or to
expand and collapse a time period.

Timeline 

button
42



Using Charts and Grids to Explore Data
View with the Timeline visible

• To isolate a time period, select it on the timeline. To select multiple
periods, hold down the Ctrl key while selecting.

• To expand or collapse time periods, right-click on the timeline. From the
list that appears, select a time level. The timeline updates.

Using Actions
An Action is supplemental information about a dimension or member, such
as a Web site, spreadsheet, or text document. Actions are created and
maintained by the cube administrator.

The indicator that an Action is available—a small green triangle —
appears in the following places:

• On a chart— In the callouts that appear when you touch the mouse to the
Rows legend

Timeline
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• On a grid—In individual cells

• On the Dimensions tool—Next to dimension or member names

To access an Action, do the following:

1. Right-click on the item denoted with a green triangle.

2. Point to Actions to display a list of available Actions.

3. Select one of the listed Actions to open it.

4. Close the document (or Web site) to return to your data analysis.

Using the Analyze feature
The Analyze feature allows you to use a Decomposition Tree to explore a
selected value.

1. Select a value you want to analyze by right-clicking on one of the
following:

• Chart—A chart series (bar or pie slice) or an item in the Rows legend
• Grid—A grid cell value
• Perspective—A Perspective data point

2. Point to Actions, and select Analyze. The value you selected to analyze
becomes the top node of a Decomposition Tree.

For more information 

about the 

Decomposition Tree 

and Perspective tool, 

see Chapter 5.
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Filtering data
While exploring data, you may prefer to work with only subsets of the data.
For example, you may wish to include only those products that rank in the
top 20% by sales dollars.

One reason to work with a subset is that some of your dimension groups
(hierarchies) may contain a very large number of members. For example, the
distributor group of an indirect customer dimension could contain over 100
members. When you want to include such a dimension in an analysis, use
filtering to create a smaller subset to work with. Doing so will reduce the
amount of time a query (such as a drill down) requires to return a result, and
the result will be more readable.

Using the Filtering feature

1. Right-click on the background of a chart or grid.

2. Select Filtering to open the tabbed Filtering box.

Filtering box

Tips

• Because filtering criteria relates to rows and columns, it is easier to visualize the data 

being filtered if you display a grid view or split chart and grid view.

• You can display subtotals to filter by.

Right-click on a grid background and select Subtotals.

• If a slicer is displayed, special filtering considerations apply. Consult ProClarity Desktop 

Client Online Help.
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3. To hide columns or rows that are empty (contain no data values), select
one or both of the check boxes. Note that these check boxes correspond to
the Hide feature in the Dimensions tool (see page 29).

4. To select other filter criteria, click the Advanced tab.

Advanced Filtering tab

5. In the primary filter area (First filter rows on), click Isolate or
Eliminate.

6. Click the down arrow to select a criterion. The following explains the
filtering criteria:
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After you select a filtering option, more selection boxes appear.

None No filtering. Choose this option to turn off the 

filtering function.

Top (Count) The rows that contain the top (count) values.

Bottom (Count) The rows that contain the bottom (count) 

values.

Top (%) The rows that compose the top specified 

percentage of the column.

Bottom (%) The rows that compose the bottom specified 

percentage of the column.

Top (Sum) The rows with the largest values that, when 

summed, compose at least the value you 

specify.

Bottom (Sum) The rows with the smallest values that, when 

summed, compose at least the value you 

specify.

Above The rows that have values above the number 

you specify.

Below The rows that have values below the number 

you specify.

Between The rows that have values between the two 

numbers you specify.
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Advanced Filtering tab with criteria selected

7. Enter the count, percentage, or amount for the criterion.

8. In the Based on boxes, select the filter details.

• Select a column for the first box.
• Select a measure for the second box. You can select any measure

contained in the cube, even if it is not a currently displayed measure.

9. (Optional) To define a secondary filter, complete the Then filter rows on
area. Secondary filters are applied to the data that remains after the
primary filter is applied.

10.Click OK to view the result of the filtering sections.

Filters remain in effect until you do any of the following:

• Select None as the filtering criteria.
• Change the layout view using the Dimensions tool (see “Arranging the

layout” on page 31).
• Reset the view (see “Resetting the View to Defaults” at the end of this

chapter).
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Understanding how to filter rows based on 
columns
You filter row data based on column data. The following illustrates this
concept.

Data before filtering

Isolating the top two rows based on the 4 column and the 5 column
respectively, would display the following differing results:

Result of isolating the Top 2 rows based on the 4 column
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Result of isolating the Top 2 rows based on the 5 column

Sorting data
The sort function allows you to display data sequentially in ascending or
descending order.

Using the Sort function

1. Right-click on the background of a chart or grid.

2. Select Sorting to open the Sorting box.

The Sorting box
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3. Click the down arrow to select the column by which you want to sort
the rows.

4. Click Ascending or Descending.

5. Click Preserve Peer Groupings to restrict sorting within the groups
contained in the row dimensions.

6. Click OK.

The new view will reflect your selections.

Sorting remains in effect until you do one of the following:

• Select None as the filtering criteria.
• Change the layout view using the Dimensions tool (see “Arranging the

layout” on page 31).
• Reset the view (see “Resetting the View to Defaults” at the end of this

chapter).
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Understanding how to sort rows by columns
You sort rows data by columns data. The following illustrates this concept:

Data before sorting

Sorting the data in ascending order by Quarter 1 and Quarter 3, respectively,
displays the following differing results:

Result of sorting in ascending order by Quarter 1
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Result of sorting in ascending order by Quarter 3

Understanding peer groupings
If you have only one dimension on the Rows, you can preserve peer
groupings. Preserving peer groupings restricts sorting within the groups
contained in the Rows dimensions. If you do not preserve peer groups,
sorting applies to all items. The following illustrates this concept:

Data before sorting
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Result of sorting with Preserve Peer Groupings selected

Result of sorting without Preserve Peer Groupings selected
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Modeling (writeback)
You can change data values to create a model for tasks such as forecasting
and budgeting. When you use modeling (also called “writeback”) to change
a value, data contributing to that value changes also according to the
allocation you specify.

1. From the File menu, point to Modeling. If Enable Grid Editing is not
checked, select it.

2. Obtain the Modeling Options box by doing one of the following:

• On a grid, click a cell and type in a new value.
• On a chart, right-click a series (example: bar or pie slice), point to

Advanced, and select Edit Value.
• On a displayed chart toolbar, click the Write Back button, then drag the

part of the chart representing the value you want to change (example, a
bar or pie slice).

3. In the Modeling Options box, specify the new values and how to allocate
them.

4. Click OK.

5. To save the changes to the cube, from the File menu, point to Modeling,
then select Commit. To cancel the changes, from the File menu, point to
Modeling, then select RollBack. This will restore values existing since
the last Commit.

Refer to Online Help for more information about using specific features of
the Modeling Options box.

Notes 

• The modeling feature is available only if the current cube has been write-enabled. If some 

of the menu commands or buttons described below are not available, see your system 

administrator.

• Before you use modeling, drill down on your data so that you are at the lowest level 

possible in the hierarchy. Otherwise, the modeling function may take a long time to 

complete.

To display a chart 

toolbar, right-click on 

the background of a 

chart and select 

Toolbar. See 

page 59 for more 

information about 

using the chart 

toolbar.

Write Back

button
55



Using Charts and Grids to Explore Data
Special grid features
ProClarity Desktop Client provides a variety of features you can use to
customize the way grids arrange and display data. The following sections
discuss four of these features:

• Subtotaling
• Exception Highlighting
• Changing grid properties
• Specifying value and percent of total options

Subtotaling
When cube data is displayed in a grid, you can display and hide subtotals.
Subtotals can be calculated for data in Columns, Rows, or both. You can also
filter and sort by subtotals.

1. Right-click on the background of a grid.

2. Point to Subtotals.

3. Select the subtotal display option you want to use. The corresponding
subtotals will be added to the grid.

4. To remove subtotals from the grid, select Off from the Subtotals menu.

Exception Highlighting
You can format grids so that values within specified ranges are highlighted.

1. Right-click on the grid and select Exception Highlighting.

2. In the first Exception Condition 1 box, select the exception you wish to
highlight.

3. Use the arrows in the subsequent boxes to define the limits of the
exception.

4. To define the appearance of the exceptions, click the Configure
Highlight Format button and choose colors and font styles. An example
of your selections appears in the Highlight Preview box.

Note

Subtotals will continue to be displayed for all future grid views until you turn them off.
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5. To specify another exception, click Add.

6. When you have defined all exceptions, click OK.

Changing grid properties
On the Grid Configurations Options box, you can change the grid colors
and fonts, set Drill To Detail limits, and select whether to use cell formatting
properties.You can also specify value formats and percentages for display,
which is discussed in the next section, “Specifying Value and Percent of
Total Options for the Grid.”

1. Right-click on a grid and select Properties to display a Grid
Configurations Options box.

2. From the list on the left side of the box, select the feature you want to
change.

3. Click the appropriate tab.

4. Select the properties you want from the tabbed page.

5. When you are finished making changes, click OK.

The following section explains more about the Values to Display tab of the
Grid Configurations Options box.

Specifying value and percent of total options 
for the grid
The options on the Values to Display tab of the Grid Configuration
Options box allow you specify how values should display, and whether and
how percentages of totals should display. Percentages of totals indicate the
contribution of a cell value to a specified total.

Tip

To eliminate a defined exception, click Delete and select the exception you wish to delete.

Cell formatting 

properties are 

properties (such as 

background color 

and font style) that 

may have been set 

in the database to 

flag certain 

conditions. For more 

information about 

them and how they 

affect Exception 

Highlighting, see 

ProClarity Desktop 

Client Online Help.
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The Values to Display tab

The following illustrates a grid that displays values scaled to thousands and
percentages of the grand total.

Grid with Percent of Grand Totals displayed

Online Help provides a detailed description of how to use Value and Percent
Options.

Special chart features
ProClarity Desktop Client provides a variety of features you can use to
customize the way charts arrange and display data. This section discusses the
following:
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• The chart toolbar
• Working with three-dimensional charts
• Customizing chart axes
• Changing how series are displayed
• Changing chart properties

The chart toolbar
ProClarity Desktop Client provides a separate toolbar you can use to
conveniently select chart types and change the data display.

The chart toolbar

To display the chart toolbar, right-click on the background of a chart and
select Toolbar.

Working with a three-dimensional chart
On the chart toolbar, click the 2D/3D Toggle button. When the chart is
three-dimensional, the Move, Rotate, and Zoom buttons are active.

Using Move

1. On the chart toolbar, click the Move button. The cursor becomes a moving
tool.

2. Hold down the left mouse button while dragging the cursor over the chart.
The chart moves in the direction of the cursor.

Using Rotate

1. On the chart toolbar, click the Rotate button . The cursor becomes a
rotation tool .

2. Hold down the left mouse button while dragging the cursor over the chart.
The chart rotates in the direction of the cursor.

Horizontal

Line

Chart

Point

Chart

Line

Chart

Pie

Chart

Area

Chart

Bar

Chart

Zoom

Rotate

Move

Write

Back

Drill

Down

2D/3D

Toggle

Chart

Properties

2D/3D Toggle

button

Move button

Moving tool

Rotate button

Rotation tool
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Using Zoom

1. On the chart toolbar, click the Zoom button . The cursor becomes a zoom
tool .

2. Hold down the left mouse button while dragging the cursor over the chart.
To zoom out, move the cursor up. To zoom in, move the cursor down.

Customizing chart axes
The following procedures describe how to change the scale and position of
chart axes and rotate axes labels.

Scaling an axis

1. Right-click on the background of a chart and select Chart Properties to
display the Chart Properties box.

2. From the list on the left, select the appropriate chart axis.

3. Click the Axis Scaling tab.

4. Set the scaling options you want to use.

5. Click OK.

Positioning an axis

By default, ProClarity Desktop Client scales all series (row items) to the left
axis (or for horizontal bar charts, the top axis). However, you can include a
second axis for one or more series and set separate scaling on each axis. This
is particularly useful when two row measures have distinctly different
measurement units (for example, an item count vs. a growth percentage).

1. Right-click on a chart series (example: a bar chart bar) or on an item in the
Rows legend, and select Series Properties.

Zoom button

Zoom tool

Tip

For ways to specify exactly how much to Zoom, Rotate, or Move a chart, see Online Help.
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2. For the Y Axis, click Right (or for the X Axis, click Bottom).

To scale either the right or left axis, follow the above "Scaling an axis"
procedure.

Rotating axes labels

1. Right-click on the background of a chart and select Chart Properties to
display the Chart Properties box.

2. From the list on the left, select the appropriate chart axis.

3. On the right, click the appropriate Axis Labels tab.

4. Select the Rotate Axis Labels check box.

Changing how series are displayed
Each member of a row dimension is a series. Series are represented by the
bars, areas, pie slices, lines, or points of a chart and by the individual entries
on the Rows legend.

You can customize the appearance of a series in two ways:

• Changing the chart type for a series using the Series Type option.
• Changing the display properties for a series using the Series Properties

option.

Change the chart type for a series

1. Right-click on a series (a bar or pie slice) or an item listed in the Rows
legend.

2. Point to Series Type and select a chart type for the series. The chart
changes to reflect your selection.

Change the display properties for a series

1. Right-click on a series or an item listed in the Rows legend.

2. Select Series Properties to display the Series Configuration box.

Tip

On the Chart Properties box, select Auto Y Axis to automatically set a second axis when the 

Rows include more than one measure.
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3. In the Series Configuration box, make selections to customize the type,
style, color, and axis.

4. Click OK.

For more information about changing the Series Properties, refer to Online
Help.

Changing chart properties
You can customize the appearance of charts by changing the colors, text
formats, and value formats in the Chart Properties box.

1. Right-click on the background of a chart and select Chart Properties.

OR

From the chart toolbar, click the Chart Properties button.

2. From the list on the left side of the Chart Properties box, select the
feature you want to change.

3. Click the appropriate tab.

4. Select the properties you want from the tabbed page.

5. When you are finished making changes, click OK.

Refer to ProClarity Desktop Client Online Help for more information about
customizing the appearance of a chart.

Resetting the view to defaults
After using various features to explore your data, you may want to restore
the view to its default settings.

To do this, from the View menu, select Reset to Defaults.

• All dimension hierarchies are rolled up to the highest level.
• All sorting and filtering is turned off.
• The view type becomes a vertical bar chart.

Chart 

properties
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Chapter 5: Using the Decomposition Tree 

and Perspective Tool
This chapter introduces you to the Decomposition Tree and Perspective tool,
and explains how to display a Web page in a view. For more detailed
information about the specific features and use of these tools, refer to
ProClarity Desktop Client Online Help.

Using the Decomposition Tree
The Decomposition Tree allows you to visually decompose information
along any dimension and expose the contributing factors. Using
Decomposition Trees, you can answer questions such as “Which foods are
the biggest sellers?” or “What percentage of the overall Quarter 2 sales are
represented by canned foods?”

A Decomposition Tree breaks a measure apart (decomposes it) into its
subcomponents, then displays the subcomponents in a hierarchical tree and a
pareto chart. Decomposition Trees can order data from largest to smallest or
from smallest to largest. Decomposed data is provided both in raw numbers
and in percentages of total. In addition, pareto charts show what components
fall above or below a particular percentage, enabling you to quickly identify
components that contain the greatest percentage of the total.

The Decomposition Tree Wizard guides you through the steps necessary to
create a Decomposition Tree. By selecting values from a series of screens,
you determine the measure to be decomposed and the dimensions to be
included at the starting point of the tree.

Creating a Decomposition Tree
The Decomposition Tree Wizard allows you to specify the measure and
starting decomposition point for a Decomposition Tree.

Note

It is recommended that you close the Dimensions tool before creating a Decomposition Tree 

view. It will give you more space and eliminate confusion as to which members are selected in 

the view.
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1. Open the Decomposition Tree Wizard by doing one of the following:

• On the toolbar, click the Decomp button.

OR

• Click the arrow beside the View button, point to Advanced Analysis
Tools, then select Decomposition Tree.

OR

• From the View menu, point to Advanced Analysis Tools, then select
Decomposition Tree.

2. Click Next on the Welcome screen to display the Decomposition Tree
Wizard screen.

The Decomposition Tree Wizard screen

3. Select the measure you want to decompose in the Values box. If the
measure you need is not listed, click the Create button to create one.

Decomp

button

View

button
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4. Select the dimension you want to decompose in the Items box. This
defines the top (beginning) node of the Decomposition Tree.

5. Click Finish to display the Decomposition Tree for the measures and
dimensions you selected.

A Decomposition Tree view

Note

If you want to select a particular dimension member or items from multiple dimensions, click 

the Advanced button to open the Grouping Items Editor.
65



Using the Decomposition Tree and Perspective Tool
Working with the Decomposition Tree
• To expand the tree to display components of a displayed dimension (drill

down), click the dimension member. In the following expanded
Decomposition View, (All) Product and Food have been expanded.

Decomposition Tree expanded to show Food items

• To expand a new member down to the same level as a currently expanded
member, hold down the Ctrl key when you click the new member.

• To drill down on a different dimension, right-click a node, point to Drill
Down, point to a dimension, then select an item.

• The current level is highlighted (Product Department). The bars of the
pareto chart correspond to the current level. To change the current level,
click a level name (for example, Product Family).

• To see how a percentage relates to the group and to the topmost total,
point to the percentage.

• To collapse the tree, click the dimension member you want to collapse.
The levels below the member are cleared from the view.

• Nodes labelled “Top” or “Bottom” contain members that the screen does
not have room to display, and summarizes the values of those members.
To display a set of the members, click the Top or Bottom node.

• You can insert a level from a new dimension anywhere in the tree. The
levels above and below the insertion remain expanded and selected as they
were, and the numerical information adjusts to the change.On the left side
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of the tree, right-click on a level label, point to Insert level, then select the
dimension level you want to insert. To remove a level, right-click on a
level label, and select Remove level.

• To obtain a list of individual records contributing to a node value, right-
click on the node, point to Drill Down, and click Drill To Detail.

• To start a new tree from an item, right-click on the item, then select Start
new tree. A new tree opens on the screen with the starting item at the top.

Working with the pareto chart

• The pareto bars represent the items on the current level, including items
contained in the Top or Bottom summary nodes. Clicking on a pareto bar
will display the corresponding member from a summary node.

• To toggle hiding/displaying the pareto chart, click the pareto chart
button.

• To toggle hiding/displaying the percent-of-total line on the pareto chart,
click the percent-of-total line button.

• To toggle hiding/displaying grid lines in the pareto chart, click the mouse
near the left or right axis to hide or display gridlines representing values,
percentages, or both.

Customizing a Decomposition Tree
You can customize many properties of a Decomposition Tree and pareto
chart. A few examples are colors for nodes and their connectors, the color of
a selected item, the size of node boxes, numeric formatting, and node text
formatting.

1. Right-click on the background of a Decomposition Tree and select Prop-
erties to display the Decomposition Tree Viewing Properties box.

2. Select the area of the Decomposition Tree you want to customize and the
properties for the area.

3. When you are finished making selections, click OK.

Using the Perspective tool
The Perspective tool provides a way for you to analyze and compare the
relationship between two sets of measures for a particular dimension. In
contrast with most data analysis tools that can work only with limited
quantities of data, Perspective enables analysis of large volumes of data.
Through Perspective views, you can gain perspective over thousands of

For more 

information about 

Drill to Detail, see 

page 39.

pareto chart

button

percent-of-total

line button

For more 

information about 

customizing a 

Decomposition 

Tree, see ProClarity 

Desktop Client 

Online Help.
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points of data and see the relationships those data points have with each
other. If you are performing quadrant analysis, plotting high volumes of
data, or wish to map multiple measures simultaneously across a dimension,
Perspectives views can provide insight into the information you seek.

A Perspective view can help you answer such questions as:

• Who are my most profitable customers? (What is revenue versus
profitability?)

• How did forecasted revenues compare with actual revenue?
• How do budgeted figures compare with actual numbers?

Creating a Perspective view
1. From the View menu, point to Advanced Analysis Tools, then select Per-

spective.

OR

Click the arrow beside the View button, point to Advanced Analysis
Tools, then select Perspective.

Perspective Wizard step 1

2. To change items selected for a dimension, click the dimension, then click
the Change Selection button to open the Change Selections box.

If you do not select an item for a dimension, the dimension is rolled up to
its highest level (the level that includes all members), and the dimension is
not displayed in the Perspective view.

View

button
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3. When you are finished making selections, click Next to proceed to the
next wizard screen.

Perspective Wizard step 2

4. Select the measures that you would like to see a relationship between (for
example, Store Cost and Store Sales) from the drop-down menus for the Y
Axis and the X Axis Measures.

A Create button for each axis allows you to open the Calculated Measure
wizard, which guides you through the process for creating calculated
measures.

5. Click Finish to display the data in a Perspective view.

Working with a Perspective view
After you have generated a Perspective view for a particular data set, you
can manipulate the image to make the information more useful. The
following describes various features you can use to change the view.

Tip

To find a dimension member, click  in the Change Selections box. For more information, 

see “Finding dimension members” on page 27.
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A Perspective view

• To enlarge the text and images in the view, use the Zoom feature.
- Zoom in: Position the cursor above-left of the data area you want to

enlarge. Click and hold the left mouse button and drag downward to the
right, then release the mouse button. Select Zoom.

- Zoom out: Position the cursor below-right of the data area. Click and
hold the left mouse button and drag upward to the left, then release the
mouse button. You can also right-click on the enlarged area and click
Zoom Out.

• To move objects around on the screen, use the Panning feature. Position
the cursor in the area. Hold down the Shift key, click and hold the left
mouse button, and drag the mouse.

• To see information about what a data point represents, point to it.
• To change the position of the slider bar (to create a reference line) on the

X and Y axes, click and hold a slider bar arrow, then drag it with the
mouse.

• To change the type of data indicated by the slider bar, right-click on the
view. Point to Statistical Sliders and point to either Horizontal or
Vertical to indicate either raw or percentage data for either sums or
counts.

Measures 

drop-down 

list button

Slider bar

Measures drop-down 

list button Slider bar
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• To change the measures displayed on an axis, right-click on the view and
select Configure Axes. Use the Configure Axes box to specify the
measures. Or, right-click on the down arrow next to the axis label, and
select a new measure from the list.

• To change the measures displayed on an axis, do either of the following:
- Right-click on the view and select Configure Axes. Use the Configure

Axes box to specify the measures.
- Click on the down arrow next to the axis label, and select a new measure

from the drop-down list.
• To start a Decomposition tree from a displayed data point, right-click on

the data point, point to Actions, and select Analyze.
• To obtain a list of individual records contributing to a data point, right-

click on the data point and select Drill To Detail.

Customizing a Perspective view
You can customize Perspective properties, such as background color and
data point size. You can also set custom attributes for the shape and color of
data points.

Changing properties

1. Right-click on the background of the Perspective view and select Proper-
ties to display the Perspective Property Configuration box.

2. Select the area you want to customize, then specify the properties for the
area.

3. When you are finished making changes, click OK.

Changing data point attributes

1. Right-click on the background of the Perspective view and select Data
Point Attributes to display the Data Point Attributes box.

2. Make selections in this box to change the attributes of any dimension’s
data points so they can be distinguished in the Perspective view.

3. When you are finished making changes, click OK.

For more 

information about 

Drill to Detail, see 

page 39.

For more 

information about 

customizing a 

Perspective view, 

see ProClarity 

Desktop Client 

Online Help.
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Using the Internet Explorer view
You can display a Web page in a view.

1. From the View menu, point to Advanced Analysis Tools, then select
Internet Explorer.

OR

Click the down arrow beside the View button, point to Advanced
Analysis Tools, then select Internet Explorer.

2. In the Internet Explorer Address box, enter the URL for the Web page
you want to display.

3. Click OK.

View

button
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Chapter 6:  Saving and Sharing Views
After you have used ProClarity Desktop Client to analyze your data, you
may want to save your analyses for personal use or for sharing information
with others. The methods you use to save and share views depend on the
purposes you have in mind. This chapter describes the following methods
that are based on the purposes each method serves:

• Personal Use/Monitoring: You can save views for your own personal use
with the following:
- Favorites
- My Views (explained in Chapter 7)
- Briefing books
- Export to Outlook®
- Printed views and briefing books

• Communicating: This enables you to send views to a small number of
people. The views can provide analysis capabilities to readers who have
ProClarity components installed. You can communicate views with the
following:
- E-mail

• Presenting: You can save views to use in reports or presentations with the
following:
- Export to Excel
- Export PowerPoint®

Chapter 7 describes the following:

• Online Publishing: Publishing enables you to deploy views to many
people at once. Published views can provide analysis capabilities to
readers or be “static” read-only views. The following are methods of
online publishing:
- ProClarity Server
- Active Books
- Export to Web Part
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Personal Use/Monitoring
You can save favorites and briefing books for future access. And you can
save a view that displays in Outlook so that you can monitor changes that
occur in the data.

Favorites 
A favorite is a view that you save on your personal computer for future
reference. You can save a favorite as your home page.

Displaying the favorites list

The Favorites list provides access to all saved favorites, and provides buttons
for adding and organizing favorites.

To display the list, do one of the following:

• From the toolbar, click the Favorites button.

OR

• From the Favorites menu, select Show Favorites.

When you select a favorite from the list, the view appears on your screen.

To close the list, click the “X” in the upper-right corner of the list.

Saving the current view as a favorite

1. With a view displayed on the screen, do one of the following:

• In the Favorites list, click the Add button.

OR

• From the Favorites menu, select Add to Favorites. The Add to
Favorites box appears.

Favorites

button

Tip

You can also access a favorite directly from the Favorites menu by selecting one of the 

favorites listed on the bottom portion of the menu.
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Add to Favorites box

2. In the Add to Favorites box, type a name for the displayed view or use
the default name provided.

• To specify a folder in which to save the view, click the Create In
button. To create a new folder, click the New Folder button on the
Create In box.

• To display this view when you first open ProClarity Desktop Client,
select the Make this page the home page option.

3. Click OK.

Organizing and changing favorites

Use the Organize Favorites box to copy, move, rename, delete, or create
folders for favorites, and designate a favorite as a home page.

1. From the Favorites menu, select Organize Favorites.

OR

On the Favorites list, click the Organize button.

2. In the Organize Favorites box, click on a favorite to select it.

3. Click the appropriate button to delete, copy, move, rename or create a new
folder. You can also designate a favorite as the home page by clicking on
the Home Page option.

4. Click Close.
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Briefing books
Briefing books are compilations of views (pages) that can be organized into
folders.

You can save a briefing book to your personal computer for your own use.
Usually, however, you will share briefing books with others. You can e-mail
them, export them (to Outlook, PowerPoint, or as a Web Part to be used in a
digital dashboard), and publish them (as an Active Book or to ProClarity
Server).

This section describes how to create briefing books and save them to your
computer. Later sections and the following chapter describe how to use them
to share information with others.

The current briefing book

The current briefing book is the one you have open in your application. Only
one briefing book can be open at a time.

• To open a book published to ProClarity Server, from the File menu, point
to ProClarity Server, then select Retrieve Book.

• To open a book not published to ProClarity Server, from the File menu,
select Open Book.

• If you have a briefing book open and want to start a new one, from the File
menu, select New Book. An empty, untitled book becomes the current
book.

• If you connect to a cube without opening an existing briefing book, an
empty, untitled book becomes the current book.

Displaying a list of current briefing book pages

A list of pages in the current briefing book automatically displays when you
open the book, add pages to it, or organize it.

To close the list, click the “X” in the upper-right corner of the list.

Publishing is 

explained in Chapter 

7.
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To reopen the list, do one of the following:

• From the Book menu, select Show Book.

OR

• From the toolbar, click the Book button.

Creating a briefing book

1. Add pages to the current book.

2. (Optional) Select publishing properties to specify the analysis capabilities
the book will provide.

3. (Optional) Configure actions for dealing with cube data changes (for
example, a dimension member included in a briefing book view is deleted
from the cube).

4. Name and save the briefing book.

The following four sections briefly explain these steps. For more detailed
explanations, see Online Help.

Add pages to the current briefing book

1. Create a view that you want to include as a page in the current briefing
book.

2. From the Briefing Book list, click the Add button.

OR

From the Book menu, select Add to Briefing Book.

Add to Briefing Book box

Book 

button
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3. In the Add to Briefing Book box, type a name or use the default name for
the page.

To specify a folder in which to save the view, click the Create In button.
To create a new folder, click the New Folder button on the Create In box.

4. Click OK.

Select publishing properties (optional)

When you create a briefing book, you can set publishing properties to
control the analysis features that are available when a briefing book is
viewed within an application other than ProClarity Desktop Client (for
example, in the Rich Client or in a PowerPoint presentation). A briefing
book viewed in ProClarity Desktop Client includes full analysis capabilities,
regardless of any publishing options that have been set.

You can set separate properties for each page and folder, plus overall
properties for the book. Page properties apply to a single page, Folder
properties apply to all pages within a folder, and Book properties apply to all
pages within a book.

By default, all properties are selected. When you use a Publishing
Properties box, you clear options that you do not want to include. Some
options encompasses a set of properties. For example, Navigate Foreground
includes the MDX Editor, English Query, and New Tree (for a
Decomposition Tree).

To open a Publishing Properties box, do the following:

1. In the Briefing Book list, right-click on a page or folder.

2. Select the appropriate command for the kind of publishing properties
(such as Page, Folder, or Book) you want to set.

3. In the Publishing Properties box, clear options for properties that you do
not want to include, and leave ones selected that you do want to include.

Tip

To add views from a local cube to a briefing book, from the File menu, select Options. On the 

Other tab, select OK to use Local Cube Files in a Briefing Book. Other users of the briefing 

book will need access to the local cube.

For an explanation of 

individual publishing 

properties, see 

ProClarity Desktop 

Client Online Help.
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4. When you are finished selecting, click OK.

Configure the book to deal with cube changes 

(optional)

While creating a briefing book, you can specify actions to be taken if the
cube data changes—for example, if a dimension member is renamed,
moved, or deleted—which causes the briefing book to contain missing
items.

1. To display the Briefing Book Configuration box, from the Book menu,
select Configuration.

2. Double-click an item listed under Type to specify the action to be taken if
an item of this Type becomes missing in the briefing book.

3. Click OK, then double-click another Type.

4. Repeat steps 3-4 until an action for each Type has been specified. If you
do not specify an action, the default action will be Prompt user.

Notes

• Book properties override Folder properties, and Folder properties override Page 

properties. For example, if you select the Drill to Detail for a folder, all of the pages in the 

folder will provide the drill to detail capability, even if you do not select it for each page in 

the folder.

• If you set publishing properties for a saved book, be sure to resave the book.

• If the Publishing Properties menu commands are not available, your application does not 

support them.

• Properties you set become the default properties if you publish the book to ProClarity 

Server. You can refine properties when you publish (see “Setting publishing properties” on 

page 92).

Notes

• The Check Against Cube and See all renamed items options are administrative 

functions. For an explanation, see ProClarity Desktop Client Online Help.

• If you open a briefing book and it contains blank pages or some missing data, the reason 

may be that the author configured it to disable pages or drop items in the event of cube 

data changes. If a prompt appears to resolve the missing items, select an option. Click the 

Help button on the dialog box to obtain an explanation of the options.
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Name and save the book

1. From the File menu, select Save Book As to display the Save ProClarity
Briefing Book box.

2. In the field for specifying a file type, select one of the following:

• Briefing Books (*.kb3): results in one .kb3 file.
• XML Briefing Books (*.xml): results in an XML file for each briefing

book page, plus two more XML files: the book file (<book name>.xml)
and the metadata file (<book name>_MDStore.xml).

3. Specify where to save the files, or accept the defaults.

4. Select the option for saving the file.
The book's name appears in the title bar.

Organizing and changing briefing book pages

The Organize box allows you to copy, move, rename, delete, and create
folders for briefing book pages.

1. To display the Organize box, do one of the following:

• From the Book menu, select Organize Briefing Book.

OR

• From the Briefing Book list, click the Organize button.

2. In the Organize box, click the view you want to organize, copy, or
change.

3. Click one of the organization buttons (for example, Move or Copy).

4. When you are finished organizing, click Close.

Tips

• You can drag pages into folders with the mouse. To create a folder, click New Folder.

• To retain the organization, resave the book before opening a different book.
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Editing a briefing book page

1. Open the briefing book page that you want to edit.

2. Click the Page Edit button. The briefing book page is in edit mode.

3. Edit the page.

4. When you have completed editing the page, click the Page Edit button
again.

Deleting a briefing book

To delete an entire briefing book, use Windows Explorer to locate the .kb3
file and delete it or to locate the appropriate .xml files and delete them.

Version 2.0 and version 3.0 books

ProClarity Desktop Client version 3.0 briefing books are compatible with
version 4.0. To use version 2.0 books with version 4.0, please contact
Technical Support.

Export to Outlook
The Export to Outlook feature makes the current briefing book usable from
within Microsoft Outlook. As cube data changes, the Outlook views reflect
the changes. You must have Outlook 2000 or newer to use this feature.

To export the current briefing book, do the following:

• From the File menu, point to Export, then select Export to Outlook.
A wizard displays to guide you through the rest of the export process.

The export process creates an .htm file and a .kb3 file, plus a link to the book
in the Outlook Folder List. When the export is finished, Outlook will open,
and you can display the book from the Folder List.

Page Edit 

button
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·

Sharing a book exported to Outlook

Because each computer has its own unique Outlook environment, the
exported files will work only on the computer on which the export feature is
run. If you would like to place a briefing book in someone else's Outlook
environment, e-mail the briefing book and have the recipient run the export
feature on his or her machine.

Deleting a book exported to Outlook

Delete all of the following:

• The .htm and .kb3 files
• The link in the Outlook Folder List

Printed views and briefing books
You can print a single view or the current briefing book.

1. With a view displayed on your screen, select Print from the File menu to
open the Print dialog box.

2. Select whether to print the currently displayed view or the entire briefing
book.

3. Set the number of copies to print.

4. To customize the appearance of the printed pages, click Page Setup and
complete the Page Setup options.

5. Click Print.

Notes

• Any options set for controlling interactivity will apply while viewing the book in Outlook.

• You cannot save any modifications you make to the views while in Outlook.

• If you export a briefing book, then modify its pages without changing the structure 

(without adding or deleting pages and folders), you only need to save the changes in the 

briefing book. You will not need to re-export the book to Outlook. However, if you add or 

delete pages in the source book, you will need to re-export it to Outlook.
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Communicating
You can share views with others by using a common communication
method: e-mail. The views can provide analysis capabilities to readers who
have ProClarity components installed.

E-mail a briefing book
1. Have the briefing book open that you want to e-mail.

2. From the File menu, select Send.
The e-mail service opens with the briefing book attached.

3. Fill out the address information and send the e-mail.

Presenting
You can export views to use in Excel reports or PowerPoint presentations.

Export to Excel
The Export to Excel feature opens the Microsoft Excel application and fills
in the spreadsheet cells with the data from the current view. You must have
Excel 2000 or newer to use this feature.

1. Display a view that you want to export data from.

2. From the Tools menu, point to Export, then select Export to Excel.

A warning appears explaining that the contents of your Clipboard will be
erased. If you click OK, the Excel application opens and data from the view
is placed within the cells of a spreadsheet.

Sharing a view exported to Excel

You can do either or both of the following:

• E-mail the worksheet.
• Save the worksheet to a server.

Deleting a view exported to Excel

To delete the output of an Export to Excel procedure, delete the Excel (.xls)
file.
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Export to PowerPoint
The Export to PowerPoint feature exports the current briefing book to a
Microsoft PowerPoint presentation. The slides can provide analysis
capabilities to readers who have ProClarity components installed. You must
have PowerPoint 2000 or newer to use this feature.

To export the current briefing book, do the following:

• From the File menu, point to Export, then select Export to PowerPoint.

A wizard displays to guide you through the rest of the export process.

When you click Finish on the last step of the Wizard, a progress bar displays
while a slide presentation is created. The export process creates the
following:

• Interactivity included: The PowerPoint presentation (.ppt file) and an
active briefing book (.ppt.kb3 file)

• No interactivity included: A PowerPoint presentation (.ppt file)

When the export is complete, PowerPoint opens in design mode. The
presentation contains a slide of the current view, or a slide for each briefing
book page, and one introduction slide.

Sharing a book exported to PowerPoint

You can do either or both of the following:

• E-mail the output files.
• Save these files to a server.

Deleting a book exported to PowerPoint

Delete the .ppt and (for interactive books) the .ppt.kb3 files.

ProClarity 

components are 

installed for those 

who use any of the 

following: Desktop 

Client, Rich Client, 

Active Books, and 

some custom 

applications.
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Chapter 7:   Online Publishing
Online publishing is a method of sharing views that enables you to distribute
briefing books to many people at once. This broad distribution is possible
because readers have Web access to published books. When you publish,
you can decide whether the books will provide analysis capabilities to
readers or be “static” read-only views.

This chapter explains the following online publishing methods:

• ProClarity Server
• Active Books
• Export to Web Part

ProClarity Server
ProClarity Enterprise Server (ProClarity Server) is a data analysis package
that includes ProClarity Desktop Client. ProClarity Server allows controlled
Web access to briefing books while providing the following benefits to
authors:

• A centralized location for storing and updating briefing books. Authors
can publish books to ProClarity Server and retrieve them from the server
to edit them. This ensures that each reader uses the same version of a
book.

• A centralized location for distributing the briefing books. Authors can
specify access rights for the books they publish. And authors do not need
to be concerned about software requirements because readers need only a
Web browser to use the books.

ProClarity Server also benefits the readers of published briefing books.
Using a Web browser, authorized readers can open published briefing books
and use the data analysis features that are included with them—without
having to download any software.

For other methods 

of sharing views, 

see Chapter 6.
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ProClarity Server components
The following is an illustration of ProClarity Server components. Following
the illustration is an explanation of how the components help you publish
and use briefing books.

ProClarity Enterprise Server (ProClarity Server)

When you publish a briefing book using the Desktop Client or Rich Client,
you can set publishing properties to define the analysis features that are
included with the book. You can also apply roles to control user access to the
books. An Administrator using the Administration Tool defines the roles,
which are composed of members with assigned permissions.

Once published, the briefing book is stored in SQL Server.

To retrieve a briefing book stored in SQL Server, a Desktop Client, Rich
Client, or Web Client user logs into the Analytic Server. When a request
comes to the Analytic Server to retrieve a book, the Briefing Book Server
component of the Analytic Server gets the book from SQL Server, enforces
the security settings, and deploys the book to the user.

Each time the user opens a page from the book or uses an analysis feature
(such as drill down or the Dimensions tool), a query is sent to the OLAP
Server database. For Web Client users, the query is communicated through
the Analytic Server to the OLAP Server, which processes the result and
sends it back for display in the Web browser. For Desktop and Rich Client
users, the query goes directly to the OLAP Server, which processes the result
and sends it back for display in the application.
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The following sections explain how to publish and manage books on
ProClarity Server:

• Showing the ProClarity Server publishing menu
• Publishing to ProClarity Server
• Retrieving a published briefing book
• Editing a published briefing book
• Managing published books
• Managing roles
• Publishing views to My Views

Showing the ProClarity Server publishing 
menu
The arrow beside the ProClarity Server button displays a publishing menu.
If the publishing menu has not been enabled, it offers only two options:
Retrieve Book and Retrieve My View. Once enabled, the publishing menu
offers the following additional options: Publish, Publish As, and Manage
Books.

1. From the Help menu, select About ProClarity Server.

2. In the About box, select the Show Publishing Menu check box.

Publishing to ProClarity Server
Once you have created a briefing book in ProClarity Desktop Client (see
“Creating a briefing book” on page 77), you can publish it to a library on
ProClarity Server.

1. Click the down arrow beside the ProClarity Server button and select
Publish Book.

OR

From the File menu, point to ProClarity Server and select Publish Book.

2. In the Publish Book screen, click on a library.
To change servers, click the Change Server button.

3. In the Book name and Description data fields, enter the appropriate
information.

ProClarity 

Server 

button

When you use the 

options of the 

Proclarity Server 

button, you are 

using the 

“Authoring Tool.”

ProClarity 

Server 

button

Change 

Server button
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4. Click the Publish button.
The current briefing book is published to ProClarity Server in the library
you selected.

Retrieving a published briefing book
1. Click the down arrow beside the ProClarity Server button and select

Retrieve Book.

2. In the Libraries pane of the Retrieve Book screen, select a library to
display its contents.
To select a library from a different server, click the Change Server
button.

3. In the Content pane, select a book.

4. (Optional) If you intend to edit the book, select Lock for editing.

5. Click OK.

Editing a published briefing book
If you have author access rights, you can edit books that have been published
to ProClarity Server.

1. Retrieve a ProClarity Server briefing book, making sure to select Lock for
editing on the Retrieve Book screen.
Locking a book prevents multiple authors from making changes to a brief-
ing book simultaneously.

2. Edit the book by doing any of the following:

• Add pages (see page 77).
• Edit pages (see page 81).
• Reorganize the book: includes deleting and renaming pages (see page 80).

Notes

• If the Publish button is dimmed, you may not have author access rights. See your system 

administrator.

• The book is published with this icon  to indicate that it is being edited. To close editing, 

open a different book or log off.

ProClarity 

Server 

button

Library

icon

Change 

Server button
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To replace the previous version of the book with your edited version, click
the down arrow beside the ProClarity Server button and select Publish
Book.

Managing published books
The Authoring Tool Manage Books screen enables you to perform tasks
such as creating new libraries and organizing books. To use the Manage
Books screen, do the following:

1. Click the down arrow beside the ProClarity Server button.

2. Select Manage Books.

3. Select an item from the left-hand pane, such as a library, book, or page.

4. Click one of the buttons to perform the appropriate task (see the following
table).

ProClarity 

Server 

button

Notes

• When you lock a book for editing, the Retrieve Book screen shows this icon  to indicate 

that it is currently being edited (is currently “locked”). To close your editing session, open 

a different book or log off.

• If the locked icon is beside a book, you can still open the book in read-only mode (without 

selecting Lock for editing).

ProClarity 

Server 

button
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5. To leave the Manage Books screen, click Close.

Managing roles
After you have published to ProClarity server, you can grant reader access
rights (reader privileges) to selected roles to make published books visible to
the members of those roles. Additionally, you can enable publishing
properties to define the analysis capabilities books will provide to readers.

Readers can do the following with the items their roles have been associated
with:

• open and view the contents of libraries
• retrieve (open) briefing books stored on the Briefing Book Server
• save briefing book views to My Views (a personal repository on the

Briefing Book Server)
• perform data analysis as provided by the publishing properties set for the

briefing book

Button Task

Toggle among the following display options: Large
Icons, Small Icons, List, and Details

Manage roles (see page 90)

View and modify properties (see “Setting
publishing properties” on page 92)

Delete an item (excluding the server)

Copy an item

Move an item

Create a new library

For more 

information about 

managing books, 

click the Help 

button on the 

Manage Books 

screen to open the 

ProClarity Authoring 

Tool Online Help.

Only an 

Administrator can 

create roles and 

grant author 

privileges.
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Granting reader access rights to roles

1. Click the down arrow next to the ProClarity Server button and select
Manage Books.

2. In the Manage Books screen, select the server, library, or book that you
want to grant reader access rights to.

3. Click the Manage Roles button.
The Manage Roles screen lists all ProClarity Server roles. The screen's
caption displays the name of the selected item (server, library, or book)
with which the roles can be associated.

4. Click in the check boxes to either grant or deny access or leave the access
right unspecified.

5. Click Apply to update the settings on the Server.

6. Click OK to close the screen.

Important As you grant or deny access rights, you should be aware that
your settings can be overridden by explicit settings at lower levels. For
example, access rights that are explicitly denied at the library level can be
overridden if they are explicitly granted at the book level.

The key icon represents the Administrator role. Members of
this role are granted all permissions: access rights and
publishing properties.

The pencil icon indicates Author privileges, which
automatically include Reader privileges

ProClarity 

Server 

button

Manage 

Roles button

You can grant 

reader access at one 

level (such as the 

library level) and 

then edit later to 

grant or deny access 

to specific items 

(such as individual 

books) contained in 

that level. For more 

information about 

editing roles, click 

the Help button on 

the Manage Roles 

screen to open the 

ProClarity Authoring 

Tool Online Help.
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The following diagram provides an example.

Access rights example

The settings in the Access rights example diagram allow members of the
Sales Representatives role to view Book A, even though they have been
denied access to the library in which it is contained. In this scenario, a
member of the role would have been given the book's specific location (or
URL) in a linked document, a Web Part, or an e-mail message.

Setting publishing properties

When you create briefing books in the Desktop Client, you can set
publishing properties to determine the interactive capabilities the book will
provide (see “Select publishing properties” on page 78). These become the
default properties when you publish the book to ProClarity Server. Using the
ProClarity Server Authoring Tool Properties screen, you can refine these
properties for the roles that have reader access to the book. You can set
publishing properties at the category level, or you can set individual
publishing properties.

To set categories of publishing properties, do the following:

1. Click the down arrow next to the ProClarity Server button and select
Manage Books.

2. In the Manage Books screen, select the level (server, library, or book) at
which you want to set properties.

3. Click the Manage Roles button.

ProClarity 

Server 

button

Manage 

Roles button
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4. In the Manage Roles screen, select a role, then click the Properties
button.

5. In the Properties screen, click the Publishing tab.
The tab displays categories of publishing properties. Individual additional
properties can be accessed with the Details button.

6. Click in the check boxes to select or clear individual items.

7. Click Apply to update the settings on the Server.

8. Click OK to apply your choices and return to the Manage Roles screen.

To select individual publishing properties, do the following:

1. Click on a category name and click Details.

2. Place checkmarks in the boxes to indicate your choices.

3. Click OK to apply your choices, or click Cancel to return to the
Publishing Properties screen.

Publishing views to My Views
My Views is a briefing book on ProClarity Server that is accessible only to
you. My Views is similar to the Desktop Client favorites.

1. Click the arrow beside the ProClarity Server button and select Retrieve
My Views.

2. Add the current view to the My Views briefing book.
(See “Add pages to the current briefing book” on page 77.)

If you have selected individual publishing properties, an icon
with a checkmark and an X appears in the category's check
box.

Properties 

button

For more 

information about 

publishing 

properties, click the 

Help button on the 

Manage Roles 

screen to open the 

ProClarity Authoring 

Tool Online Help.

ProClarity 

Server 

button

Note 

If a view you want to save to My Views comes from another briefing book, see the procedure in 

the Desktop Client Online Help for adding a view to My Views.
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Active Books
If you do not have ProClarity Server, Active Books are an alternative for
providing Web access to briefing books. An Active Book is a single view or
a complete briefing book that you save in HTML format.

When a reader opens an interactive Active Book, the ProClarity components
needed to use the book's interactive features will download to the reader's
computer. When a reader opens a read-only Active Book, the book will run
in a Web browser only and no ProClarity components will download. To
create an interactive Active Book, you must have an Active Book
deployment license key.

The following sections explain how to create and use Active Books:

• Creating an Active Book
• Sharing an Active Book
• About licensing
• Reading an Active Book
• Deleting an Active Book

Creating an Active Book
Active Books are created using the Active Book Wizard.

1. Display a view or open the briefing book you want to use to create an
Active Book.

2. For a briefing book, be sure any publishing properties you want to include
are set (see “Select publishing properties” on page 78).

3. From the File menu, point to Active Book and click Publish ActiveBook.
This starts the Active Book Wizard.

4. Complete the Active Book Wizard screens.
To display specific help about any screen, click the screen's Help button.
Characteristics you will specify include the following:

Note 

Active Book publishing is not available from the Rich Client.

For more detailed 

information about 

the purpose and use 

of Active Books, 

refer to ProClarity 

Desktop Client 

Online Help or the 

Administrator’s 

Guide 

(AdminInstall.txt). 

Topics include 

discussions about 

using HTML tags, 

formatting issues 

associated with file 

types and frames, 

and editing 

(customizing) Active 

Books. 
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• Interactivity - You can enter a license key, then specify to add
interactivity.

• Interactive attributes - These allow you to further control user
interactivity (beyond the briefing book publishing properties). For
example, you can hide the toolbar.

• Title page information.
• Storage and access file paths or URLs.

Sharing an Active Book
Step 4 of the Active Book Wizard allows you to specify the URL or file path
used for accessing the Active Book. Readers will need to know this URL or
file path to open the Active Book.

When the Active Book is initially accessed by readers who do not have
ProClarity Desktop Client 4.0, the necessary files, controls, and software are
downloaded for viewing the Active Book, and the Active Book is displayed
through the browser.

About licensing
Each user that publishes an interactive Active Book must have an Active
Book deployment license key. Each user that views an Active Book must
have a current ProClarity Desktop Client license if he or she does not have a
licensed copy of ProClarity Desktop Client installed.

Making ProClarity Active Books available for use on a Web browser
without a specific license to do so is a violation of the license agreement. To
obtain license information, contact your system administrator or your
ProClarity Corporation Sales Representative.

Reading an Active Book
The following are the minimum browser requirements for reading Active
Books that include interactivity:

• Internet Explorer: Internet Explorer version 5.0
• Netscape® Navigator: Netscape Navigator version 4.7 plus Internet

Explorer version 5.0

Read-only Active Books may be viewed with any browser that supports
frames (including Netscape Navigator version 3.0 or newer).
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The procedure for opening an Active Book depends on whether you are
accessing it from an intranet server or over the Internet.

Opening an Active Book on an intranet server

1. Open your Web browser.

2. From the browser File menu, click Open to open a file.

3. Browse to the server and folder in which the Active Book's default.htm
file is stored.

4. Open the default.htm file.

Opening an Active Book over the Internet

You can open an Active Book over the Internet from the ProClarity Desktop
Client application or from your Web browser.

From ProClarity Desktop Client

1. From the File menu, point to Web, then click Open Active Book.

2. In the Open Active Book box, type the http address and name for the
Active Book. For example: http://<address>/<Active Book name>

3. Click OK.

From your Web browser

1. Open your Web browser.

2. In the browser address field, type the http address for the Active Book's
default.htm file. For example: http://<address>/default.htm

3. Press Enter.

Deleting an Active Book
• On the server that stores the Active Book, delete the folder containing the

Active Book files.
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Export to Web Part
This feature allows a briefing book to be displayed in a Microsoft digital
dashboard (version 2.01 or newer). The book is then available to anyone
who accesses the Web site containing the digital dashboard.

If the exported book includes interactivity, the reader must have either
ProClarity Desktop Client, Rich Client, or a custom ProClarity application
installed.

The following sections explain how to use the Export to Web Part feature:

• Exporting the current briefing book to Web Part
• Sharing a Web Part
• Deleting a Web Part

Exporting the current briefing book to Web 
Part
To export the current briefing book, do the following:

1. From the File menu, point to Export, then select Export to Web Part.
A wizard displays to guide you through the rest of the export process.

2. Within the Wizard, you can save the Web Part to a file, to a specific digital
dashboard, or both. One or both of the following will then be generated:

• An .htm file and some .xml files
• A Web Part published to a digital dashboard

Sharing a Web Part
To share a Web Part, do one of the following:

• E-mail the folder containing the files generated by the export.

OR

• Within the Wizard, specify to publish the Web Part to a specific digital
dashboard.
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Deleting a Web Part
To delete a Web Part, do one or both of the following:

• Delete the .htm and .xml files.
• In the digital dashboard, click the Content button. Clear the check box

next to the Web Part. This removes the Web Part from the digital dash-
board display.

If you have administrator rights, you can remove the Web Part from the
system. Double-click the Web Part name to open an editing screen. On this
screen, select to delete the Web Part.
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Chapter 8: Using ProClarity Desktop Client’s 

Advanced Features
After you have mastered the basics of ProClarity Desktop Client, you may
want to experiment with the more advanced features of this application.
These features include wizards for creating local cubes and calculated
measures; an MDX Editor that allows you to create named sets and
calculated members; command-line arguments; and an integrated VBA
(Visual Basic® for Applications) work environment. These tools allow you
to streamline procedures and extend the functionality of your application.

How do I?
This chapter presents several methods for enhancing your performance in
ProClarity Desktop Client. Some of the tasks described here can be
accomplished in more than one way, in which case the most efficient
alternative is described.

• Apply a meaningful name to a group of members.
• Create a custom measure or member to expedite my query.
• Develop models for budgeting and forecasting.
• Create a local cube file so that I can use ProClarity Desktop Client from a

laptop.
• Pose my query in English.
• Customize the ProClarity Desktop Client startup view.
• Develop Visual Basic code from within ProClarity Desktop Client.
• Write a macro to consolidate a series of tasks.
• Create an add-in to customize my application.
• Develop a plug-in to extend functionality.

For step-by-step instructions for using the features described in this chapter,
see ProClarity Desktop Client Online Help and the Developer’s Guide.

Applying a meaningful name to a group of 

members
Data analysis is made easier and more efficient when you can group together
certain members and refer to them collectively with a meaningful name. For
example, you might want to create a set of members that represents the
Northwest region or the first four months of a year.
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Named sets establish groupings that differ from those that occur in the
natural hierarchy. More importantly, named sets are dynamic; that is, the
members they identify can change based on changes in data. For example, if
a named set represents the Top Five Cities, the cities identified within this
group would vary with changes in the data.

You can create user-defined named sets within the MDX Editor (under
View) or from the right-click menu in the Dimensions tool. The MDX Editor
offers greater flexibility in that it allows you to include members from
different dimensions. The following is an example of a named set in the
MDX Editor.

Creating a named set using the MDX Editor

Once you’ve created a named set, it appears in the Dimensions tool, where it
can be easily accessed to run a query. The following example displays the
result of a query containing the Top Five Cities named set.
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Working with named sets in the Dimensions tool

Besides user-defined named sets, there are also server-defined and briefing
book named sets. Online Help provides more information about named sets.

Creating a custom measure or member to 

expedite a query
Certain formulas, such as one that shows percentage growth for a given time
period, appear repeatedly as a component of an MDX statement, or query.
Rather than developing these commonly used formulas with each new query,
you can create a user-defined calculated member. A calculated member
combines multiple members of a dimension with arithmetic operators and
MDX functions to create a new member that can be referenced by name
within an MDX statement.

ProClarity Desktop Client distinguishes between calculated measures and
calculated members. A calculated measure appears only within the
Measures, while a calculated member can appear on any dimension.
ProClarity Desktop Client provides a wizard for developing a calculated
measure and the MDX Editor for building calculated members. The
Calculated Measure Wizard is a good starting point because it provides
predefined scenarios. For greater control and flexibility, however, you
should use the MDX Editor.
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Creating a calculated measure
To access the Calculated Measure Wizard, click the Measures tab in the
Dimensions tool and then click the Calculated Measure button.

The wizard asks you to select from four options:

• Growth—This option allows you to view a percent change or an absolute
change. Choose from prior year or prior quarter.

• Time series—These options include year-to-date, quarter-to-date, and
period-to-date. You can also specify a rolling period.

• Simple relationship—In this screen, you can select from ratio, difference,
percent of difference, or percent of markup. Additional drop-down menus
allow you to create a ratio formula.

• Custom formula—This option presents a blank data field for constructing
your own MDX expression. It includes a keypad of arithmetic operators
and other symbols, as well as the ability to specify a format string.

Creating a calculated member
Use the MDX Editor (under View) to create a calculated member for any
dimension, including the Measures dimension. The MDX Editor provides
drop-down menus for selecting dimensions and members, and for setting the
format string and solve order.

To build a calculated member, you insert metadata items, MDX functions,
and arithmetic operators into the MDX Expression window. A
Dependencies feature within the MDX Editor reveals previously created
calculated members upon which the new expression may depend.

Calculated Measure button
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The following screen example shows a calculated member that generates the
Top 10 Sales for California.

Using the MDX Editor to create a calculated member

Besides user-defined calculated members, there are also server-defined and
briefing book calculated members. Online Help provides more information
about calculated members.

Developing models for budgeting and 

forecasting
Business modeling is commonly used to develop forecasts, make
projections, and prepare budgets. ProClarity Desktop Client provides a
Modeling tool (under File) that allows you to develop What if scenarios by
changing values. To use this tool, you must be working with a write-enabled
cube.

The Modeling tool would allow you to illustrate, for example, how an
increase in advertising would affect the profitability of a particular product.
When you change a value, data contributing to that value changes according
to the allocation you specify.
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For example, you can use a weighted allocation that is based on dimension
members you select. The Modeling tool generates an MDX statement that
reflects the method of allocation you specify. See the following example.

Changing and allocating values in the Modeling tool

The Modeling tool is very effective when used with cubes containing a
limited number of dimensions. As the number of dimensions in the cube
increases, the amount of time it takes to run the query increases. See the
Online Help for instructions on how to use this tool most effectively.

Creating a local cube file to use ProClarity 

Desktop Client from a laptop
If you’re without a network connection (perhaps using a laptop), you can use
ProClarity Desktop Client to browse a local cube file instead of a cube. A
local cube file can contain part or all of the original cube, stored in a single,
portable file. To use a local cube file, you must have Microsoft OLE DB
Provider for OLAP Services installed on your computer.

ProClarity Desktop Client provides a wizard to help you create a local cube
file from a currently open cube. To access the wizard, select Create a local
cube from the File menu. Three tabs in the wizard allow you to configure
the cube’s structure, specify a Where clause, and edit the MDX expression
that defines the local cube.
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The cube’s structure is determined by the measures, dimensions, hierarchies,
and levels you select and is displayed in the local cube’s Dimensions tool.
The Where Clause tab lists the items in the current cube that will contribute
data to the local cube. The following is an example of how a cube’s structure
is configured.

Using the Create Cube Wizard

Posing a query in English
An English Query tool (under View) is available in ProClarity Desktop
Client that allows you to enter a query in plain English rather than develop
an MDX statement. To use the English Query, you must install English
Query from the Microsoft SQL Server Version 8 (or newer) setup disk.

The English Query tool relies on a Compiled Model, a set of files that
contain information about the structure and contents of an existing cube.
You can build a Compiled Model within ProClarity Desktop Client, as
shown below.
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Building a Compiled Model for the English Query feature

Customizing the ProClarity Desktop Client 

startup view
ProClarity Desktop Client supports numerous command-line arguments,
which allow you to determine how the application opens and to specify
which add-ins are loaded. For example, you can use command-line
arguments to designate the provider, server, and cube name, and thereby
eliminate the need to click through the default opening dialog boxes.

The command-line arguments also allow you to determine which view
(Grid, Chart, Perspective, or Decomposition Tree) is initially selected to
present your data. One of the command-line arguments allows you to skip
the opening dialog and immediately view data in the Chart view.

For a complete list of the command-line arguments available in ProClarity
Desktop Client, see the Online Help.
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Developing Visual Basic code from within 

ProClarity Desktop Client
ProClarity Desktop Client includes an integrated Visual Basic® Editor
(under Tools/Macro) that allows users who are familiar with Visual Basic to
automate tasks, customize the ProClarity Desktop Client interface, and
extend the functionality of ProClarity Desktop Client in other applications.

This section provides a brief overview of the Visual Basic Editor.
Subsequent sections in this chapter provide descriptions and examples of
how the Editor is used to write macros, create add-ins, and develop plug-ins.

The Visual Basic Editor provides access to the ProClarity Desktop Client
object model, which consists of over 150 objects. These objects allow
programmatic control over most aspects of the ProClarity Desktop Client
application.

The following are brief descriptions of the Visual Basic Editor components
used to customize ProClarity Desktop Client:

• Object Browser—Lists all available objects in a project as well as their
properties, methods and events.

• Properties Window—Displays design time properties for selected
objects and allows you to change their settings.

• Project Explorer—Presents a hierarchical list of projects and displays the
Code window. This component is used to develop Visual Basic code.

The Visual Basic Editor includes Microsoft Visual Basic Help, an excellent
resource for learning Visual Basic. For more information on using the Visual
Basic Editor in ProClarity Desktop Client, see the Developer’s Guide.

Writing a macro to consolidate a series of 

tasks
A macro consolidates multiple keystrokes into one, allowing you to
complete common tasks more quickly. You can create, edit, or delete macros
in ProClarity Desktop Client using the integrated Visual Basic Editor (under
Tools/Macro).

Note

The Visual Basic Editor is not available in the Rich Client.
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Following are two examples of how a macro might be used:

• To define specific attributes for data points based on dimensional value.
For example, you can write a macro that displays all chart data specific to
a certain company in blue.

• To automate tasks such as updating a briefing book page and emailing it to
specific individuals or publishing an Active book to an internal web site.

A Macros dialog box allows you to run an existing macro or create a new
one. To create a macro, enter a name in the Macros dialog box. The VB
Editor code screen appears, displaying an empty subroutine expression, as
shown in the example below:

Developing a macro in the Visual Basic Editor

Macros can be created and stored within a briefing book or in favorites. If
stored in a briefing book, they transfer with the briefing book. Macros can be
exported to a .bas file and imported into another user’s favorites. Macros
appear in the Tools drop-down menu.

Creating an add-in to customize ProClarity 
Desktop Client

Add-ins are programs you can write to modify, customize, or extend the
functionality of the ProClarity Desktop Client application. These programs
are often used to create personalized wizards or other custom macros that
run in response to a toolbar or menu option. Unlike macros, add-ins can be
distributed.
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ProClarity Desktop Client supports two types of add-ins: VBA (Visual Basic
for Applications) and COM (Component Object Model). VBA add-ins are
created within ProClarity Desktop Client, using the integrated VBA Editor.
COM add-ins, also referred to as binary add-ins, can be developed with any
language that can create COM components, including Microsoft Visual
Basic 6, Microsoft Visual InterDev®, Microsoft Visual C++®, and
Borland® Delphi™.

You can create and import VBA add-ins from within ProClarity Desktop
Client (under Tools/Add-in). Following is the dialog box for creating an
add-in. After you have assigned the add-in a name, you develop the
necessary code in the Visual Basic Editor.

Creating an add-in

For more information on developing VBA (Visual Basic for Applications)
and COM add-ins, see the Developer’s Guide.
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Developing a plug-in to extend functionality
ProClarity Desktop Client plug-ins are ActiveX® controls that work within
the ProClarity Desktop Client environment and extend the functionality of
the application. Whereas add-ins supplement existing functionality, plug-ins
provide new features. The following are a few examples of how plug-ins are
used:

• To integrate a Mapping/GIS tool with a custom selection or layout control
• To create a vertical or specialized data visualization tool for a specific

application or industry
• To migrate an existing application or data-visualization control to OLAP

Some plug-ins are standard to the ProClarity Desktop Client interface, while
others are created by third-party vendors. Standard ProClarity Desktop
Client plug-ins can be used on their own or with other controls to perform
tasks such as the following:

• The Page control can be used to limit access to a specific set of
dimensions.

• The Chart control and Dimensions tool can be attached to a specific cube
to develop a Web-based reporting system for a company’s intranet.

• The Page control and the Time Line control can be used with a custom-
built cube selector as the OLAP segment of a customer-centered supply
chain optimization application.

Third-party plug-ins can be built from scratch or by leveraging an existing
control. For detailed instructions about developing and deploying plug-ins,
see the Developer’s Guide.
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Action

An Action is a link to a supplementary document about a dimension
member. Actions are set up by the cube administrator and can be a Web
page, a special report, or any type of related information. Actions are
denoted by a green triangle in the Dimensions tool next to a member name,
in chart callouts, and in individual grid cells.

Active Books

An Active Book is a single page or complete briefing book that can be
viewed within a Web browser. It can be interactive or read-only. An
interactive Active Book downloads the components needed to use it. You do
not need ProClarity Server to publish or use Active Books.

Ad hoc queries

Ad hoc queries are questions about specific data relationships that are not
asked regularly enough to build a standard report to answer. The Ad hoc
Query Wizard simplifies and streamlines the process of posing ad hoc
queries about business data.

Authoring Tool

See “ProClarity Server Authoring Tool.”

Briefing books

Briefing books are compilations of views (pages) that may be organized into
folders. You can save them to your own computer, publish them to
ProClarity Server, e-mail them, save them as HTML (an Active Book), and
export them to Outlook, PowerPoint, or as a Web Part to be used in a digital
dashboard.

Calculated measures 

Calculated measures are calculated members defined as measures. See the
calculated members definition below.

Calculated members

Calculated members are dimension members whose values are created by
summing (or applying some other arithmetic operator to) the values of other
selected members. Calculated members can also be defined as measures
(calculated measures).
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Collapse

Collapse similar to Drill Up. Collapse displays less detail about an item
while maintaining the current display of other items.

Command-line arguments 

Command-line arguments allow you to specify how the application opens by
designating the provider, server, and cube name in a command-line
argument, rather than clicking through the default opening dialogs.

Compiled Model 

A Compiled Model is a group of files used while executing an English
Query. In order to understand a typed-in query, the English Query engine
compares the typed-in words to a pre-defined Compiled Model. If you don't
already have a Compiled Model, you can use the Compiled Model Builder to
create one based on the structure and contents of an existing cube.

Cube

Cube is the term used to describe a database used for multidimensional
analysis. Each cube contains a set of measures (quantitative data such as
Unit Sales) and dimensions (descriptive data such as Type of Product and
Store Location). As you work with ProClarity, queries are sent to the cube to
be answered, and the results are returned to ProClarity for display.

Cube cell formatting properties

Cube cell formatting properties are properties (such as background color and
font style) that have been set in the database.

Decomposition Tree

Decomposition Tree is an analysis option unique to ProClarity that breaks a
measure apart into its subcomponents. The results of the decomposition
appear in a hierarchical tree and in an optional pareto chart. By decomposing
a measure, you can clearly see the raw and percentage data that comprise
each component of a measure. By using the pareto chart, you can focus on
the changes you see in the tree to determine how those changes relate to the
whole.

Desktop Client

Desktop Client is the ProClarity data analysis application that runs in a
desktop computer as an independent application (not in a Web browser).
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Dimensions

Dimensions describe attributes (categories) of a measure. For example,
dimensions of a Sales Dollars measure might include Geographic Region,
Product Family, Sales Representative, and Customer Type. Attributes of a
dimension are called members or items.

Dimensions tool 

The Dimensions tool allows you to select dimensions and measures and
arrange them to explore data relationships. It displays a hierarchical tree of
members for each dimension.

Dimension tree 

A Dimension tree is a hierarchical arrangement of a dimension's members.
Each dimension tab in the Dimensions tool displays a dimension tree.

Drill down

Drill down enables viewing lower levels of a dimension member's hierarchy.
Drilling down increases the level of detail that is displayed.

Drill To Detail 

Drill To Detail enables viewing of the individual transactions, or records,
that contribute to a value.

Drill up 

Drill up enables viewing higher levels of a dimension member's hierarchy.
Drilling up reduces the level of detail that is displayed.

Eliminate 

Eliminate removes selected items from the current display of data.

Exception highlighting 

Exception highlighting is a feature used in a grid to highlight numbers that
meet specified conditions. For example, you could make all cells containing
numbers over 5,000 display as yellow.

Expand

Expand is similar to Drill Down. Expand displays more detail about an item
while maintaining the current display of other items.
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Filtering criteria

Use a filter to display only the portion of data you wish to view.

Hierarchy

Hierarchy refers to the arrangement of members in a dimension. Using
various data analysis features, you can explore the levels of a dimension's
hierarchy. For example, if you drill down on a quarter in the Time
dimension, you will see members at a lower level in the hierarchy—the three
months in the quarter.

Isolate 

Isolate removes all but selected items from the current display of data.

MultiDimensional eXpression (MDX) 

MDX is a set of database functions that is used to access data in
multidimensional datasets. MDX has the tools necessary to ask complex
questions of a database and quickly return information from
multidimensional datasets. To access MDX functions, create a Custom
Formula Calculated Measure or select MDX Editor from the View menu.

Measures 

Measures are quantitative values contained in a cube. Some examples of
measures are Sales Dollars, Number of Product Failures, Gross Margin, and
Average Inventory Levels. All cubes have at least one measure, and they can

None No filtering. Displays entire result of the query.

Top (Count) The top number of rows specified.

Bottom (Count) The bottom number of rows specified.

Top (%) The rows that comprise the top specified percentage
of the column.

Bottom (%) The rows that comprise the bottom specified percent-
age of the column.

Top (Sum) The rows with the largest values that, when summed,
comprise at least the value you specify.

Bottom (Sum) The rows with the smallest values that, when
summed, comprise at least the value you specify.
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have multiple measures. Measures are analyzed against dimensions
(categories). For example, you can analyze the measure Sales Dollars
against Geographic Region or Product Family. You can work with existing
measures or use the Calculated Measure Wizard to create measures based on
formulas containing existing measures.

Members

Members (also referred to as items) compose the detail associated with a
dimension. Members of a dimension appear when the dimensional hierarchy
is expanded.

Modeling 

Modeling (also called writeback) allows you to change data values to create
a model for tasks such as forecasting and budgeting.

Multidimensional analysis

Multidimensional analysis is a process of analyzing data that is organized
according to the variables (such as Region, Product, Time, and so forth) that
decision-makers find most useful in looking at their businesses.

Named sets 

Named sets are sets of dimension members that are given a name to be used
in queries. For example, if you want an easy way to display the 10
salespersons with the highest sales, you can create a named set containing
these salespersons. The set will then be available in the Dimensions tool by
name and can be selected like a dimension member.

Nodes 

Nodes are the individual “leaves” on a Decomposition Tree. A node
represents a dimension member and contains information about the
member's relative contribution to a measure (such as Sales).

OLAP (Online Analytical Processing)

OLAP is a way of analyzing data by interacting directly with the data, rather
than by viewing static paper reports. OLAP technology arranges raw data so
that someone working at a computer can view the data in graphic formats
that reflect a wide variety of relationships among the data.
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OLE DB for OLAP Provider 

It is the term used for the OLAP server software. Microsoft OLE DB
Provider for OLAP Services 8.0 is an example of an OLE DB for OLAP
Provider.

Organization options

Organization options allow you to organize favorite views and pages within
briefing books.

Perspective tool

The Perspective tool is a way for you to analyze and compare the
relationship between two sets of measures for a particular dimension. In
contrast with most data analysis tools that can work only with limited
quantities of data, Perspective enables analysis of large volumes of data.
Through Perspective views, you can gain perspective over the thousands of
points of data available to you, and you can see the relationships those data
points have with each other.

Pivoting 

Pivoting the view refers to changing the arrangement of measures and
dimensions on rows, in columns, and in the background of data views. Use
the Dimensions tool to pivot the view.

ProClarity Server

ProClarity Server (ProClarity Enterprise Server) provides controlled Web
access to ProClarity briefing books, allowing users to analyze data without
installing software on their computers.

Copy Copies a single selected page or a selected folder and its
contents.

Move Moves a single selected page or a selected folder and its
contents.

Rename Renames a single selected page or a selected folder and its
contents.

Delete Deletes a single selected page or a selected folder and its
contents.

New
Folder

Opens a dialog box for creating new folders.
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ProClarity Server Authoring Tool

The ProClarity Server Authoring Tool is used to publish books to and
retrieve books from ProClarity Server and manage security for the books.

Query 

Queries are requests for data about measures and dimensions that you select.
The results of your queries are displayed on the screen.

Rich Client

The Rich Client has the look and feel of ProClarity Desktop Client but runs
in a Web browser. Rich Client and Desktop Client users can publish to
ProClarity Server.

Series

Each series represents a row of data. Series are represented by the bars,
areas, pie slices, lines, or points of a chart and by the individual entries on
the Rows legend.

Slices

Slices of data change when you change Background member selections. In
other words, the Row and Column comparisons are based on different data
subsets (“slices”) as defined by the selected Background members.

Web Client

Web Client users access briefing books and associated analysis features
through a Web browser, without having to download software to their
computers.

Web Part 

Web Part is the term used for a collection of files required to display a
briefing book in a Microsoft Digital Dashboard Version 2.0. ProClarity
creates these files when you use the Export to Web Part feature.
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Administrator’s Guide for Active Books xiv, 94
advanced analysis tools

creating a Decomposition Tree 64
creating a Perspective view 68

advanced features 99
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using 44
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Authoring Tool
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pareto chart line indicator 67

period value 24
Perspective view

changing data point attributes 71
changing properties 71
creating a 68
customizing 71
panning 70
130



Index
purpose of a 67
using a 69
using slider bars 70
using the Wizard 68
zooming in or out in a 70

Pivoting dimensions 42
plug-ins, developing 110
PowerPoint, exporting a briefing book to 84
printing views and briefing books 82
ProClarity Desktop Client

exiting 22
installing 12
opening the Web site for 15
starting 14

ProClarity Desktop Client documentation
Administrator’s Guide xiv
Developer’s Guide xii
Getting Started Guide xii
MDX Help xii
Online Help xii

ProClarity Enterprise Server
See ProClarity Server

ProClarity Server
Administration Tool 86
Analytic Server component 86
benefits of 85
Briefing Book Server component 86
managing briefing books published to 89
OLAP Server component 86
publishing briefing books to 87
retrieving briefing books from 88
showing the publishing menu for 87

ProClarity Server Authoring Tool
buttons 90
change the display of options in 90
copying briefing books using 90
creating a new library using 90
granting reader access with 91
131



Index
managing roles using 90
moving items using 90
Online Help xiii
setting publishing properties with the 92

ProClarity Server documentation
product support xiv
Properties button in the Authoring Tool 90
publishing

briefing books to ProClarity Server 87
methods of 85
views to My Views 93

publishing properties
setting in the Desktop Client 78
setting with the Authoring Tool 92

Q
quadrant analysis 68
queries

custom, with calculated measures and members 101
developing plain English 105
using Auto Execute for 24
using the Ad hoc Query Wizard to develop 23
using the Execute button for 24

R
reader access rights 90
reading an Active Book 95
relevant data

arranging dimensions and measures that represent 5
discussion of 1

renaming
briefing books 80
favorites 75

Reset button 21
retrieving a briefing book from ProClarity Server 88
retrieving records 41
Rich Client
132



Index
explained xiii
features not available in 94, 107

right-click menus
accessing Actions 44
accessing modeling options 55
changing chart properties 62
changing grid properties 57
changing series properties 61
changing series type 61
displaying a chart toolbar 59
drilling down 36
drilling up 39
filtering data 45
inserting data 50
pivoting dimensions 42
positioning a chart axis 60
scaling a chart axis 60
using Analyze 44
using exception highlighting 56
using subtotals 56

roles
and reader access 90, 91
managing in ProClarity Server 90

Rollback
see Modeling, canceling changes

rolling period value 24
Rotate button 59
rotating chart axes labels 61
Rows

arranging the layout 31
filtering based on Columns 49
pivoting dimensions 42
sorting by Columns 52
understanding 5

S
saving and sharing views 73
screen details 10
133



Index
server
changing in the Authoring Tool 87, 88
connecting to a 17
finding a 17

sharing
a briefing book exported to Outlook 82
a briefing book exported to PowerPoint 84
a briefing book exported to Web Part 97
a view exported to Excel 83
Active Books 95
calculated members 103

Show All Column Header Text in a grid xvi
showing

items composing a Children member 36
the ProClarity Server publishing menu 87

slicer 27
slider bars in a Perspective view 70
Sort button 21
sorting

purpose 50
Rows by Columns 52
turning off 51, 62
using 50
using peer groupings 51, 53

split-screen view 35
SQL Server 86
starting ProClarity 14
subsets of data

see filtering
subtotals

in a grid 56
when filtering 45

support for ProClarity Desktop Client xiv
system requirements 11

T
tabs, changing the Dimensions tool 32
134



Index
technical support xiv
time value options 24
timeline 42
Timeline button 21, 42
Toggle button for a chart 2D/3D setting 59
toolbar buttons

customizing 21
in ProClarity Desktop Client 20

toolbar, buttons
on the chart toolbar 59

V
View button 21, 33
view types

resetting to defaults 62
selecting 34, 63, 68

Visual Basic 107

W
ways to save and share views 73
Web page, displaying in a view 72
Web Part, exporting a briefing book to 97
Welcome screen options 15
wizards

Active Book 94
Ad hoc Query 23
Calculated Measure 102
Create Cube 104
Decomposition Tree 63
Perspective 68

Writeback
see Modeling

Write Back button 55

Y
year-to-date value 24
135



Index
Z
Zoom

in a Perspective view 69
in a three-dimensional chart 59
136


	END-USER LICENSE AGREEMENT FOR PROCLARITY CORPORATION
	ProClarity Desktop Client Documentation
	Getting Started Guide
	About feature availability

	ProClarity Desktop Client Online Help
	MDX Help
	ProClarity Server Authoring Tool Online Help
	Developer’s Guide
	Administrator’s Guide

	ProClarity Enterprise Server Documentation
	ProClarity Product Support
	What's New in Version 4.0
	Chapter 1: Understanding ProClarity Desktop Client and Multidimensional Analysis
	The data problem
	Turning data into information
	Getting stuck in the report cycle

	The ProClarity Desktop Client solution
	What are OLAP and multidimensional analysis?
	Terms used in multidimensional analysis
	Understanding Rows, Columns, and Background
	How the relevant data and its arrangement affect your charts and graphs
	The Background

	ProClarity Desktop Client screen details


	Chapter 2: Installing and Starting ProClarity Desktop Client
	System requirements
	Hardware
	Software

	Installing ProClarity Desktop Client
	Starting ProClarity Desktop Client
	ProClarity Enterprise Server option
	Cube for browsing option
	Changing the OLAP Provider
	Connecting to a different server and cube

	The ProClarity Desktop Client toolbar
	Customizing the toolbar

	Moving among saved or current session views
	Exiting ProClarity Desktop Client

	Chapter 3: Using Basic Data Query Techniques
	About the Ad Hoc Query Wizard
	Using the Ad Hoc Query Wizard
	Using the Time Value options
	The Find feature

	Using the Dimensions Tool
	Executing a Query (refreshing a view)
	Selecting measures and dimension members
	Making multiple selections on a Background item

	Finding dimension members
	Hiding empty members
	Turning off the Hide feature

	Arranging the layout
	Changing the display format for the Dimensions tool tabs


	Chapter 4: Using Charts and Grids to Explore Data
	Obtaining a chart or grid view
	Displaying a chart
	Displaying a grid

	Displaying a chart and grid in a split-screen
	Toggling between views
	Drilling down
	Drilling down directly on a chart or grid
	Using the right-click menu to drill down
	Automatic switch to grid

	Drilling up
	Drilling up directly on a chart or grid
	Using the right-click menu to drill up

	Drilling To Detail
	Limiting the number of records retrieved

	Using navigation features
	Pivoting dimensions
	Using the timeline
	Using Actions
	Using the Analyze feature
	Filtering data
	Using the Filtering feature
	Understanding how to filter rows based on columns

	Sorting data
	Using the Sort function
	Understanding how to sort rows by columns
	Understanding peer groupings

	Modeling (writeback)
	Special grid features
	Subtotaling
	Exception Highlighting
	Changing grid properties
	Specifying value and percent of total options for the grid

	Special chart features
	The chart toolbar
	Working with a three-dimensional chart
	Customizing chart axes
	Scaling an axis
	Positioning an axis
	Rotating axes labels

	Changing how series are displayed
	Change the chart type for a series
	Change the display properties for a series

	Changing chart properties
	Resetting the view to defaults


	Chapter 5: Using the Decomposition Tree and Perspective Tool
	Using the Decomposition Tree
	Creating a Decomposition Tree
	Working with the Decomposition Tree
	Working with the pareto chart

	Customizing a Decomposition Tree

	Using the Perspective tool
	Creating a Perspective view
	Working with a Perspective view
	Customizing a Perspective view
	Changing properties
	Changing data point attributes


	Using the Internet Explorer view

	Chapter 6: Saving and Sharing Views
	Personal Use/Monitoring
	Favorites
	Displaying the favorites list
	Saving the current view as a favorite
	Organizing and changing favorites

	Briefing books
	The current briefing book
	Displaying a list of current briefing book pages
	Creating a briefing book
	Configure the book to deal with cube changes (optional)
	Name and save the book
	Organizing and changing briefing book pages
	Editing a briefing book page
	Deleting a briefing book
	Version 2.0 and version 3.0 books

	Export to Outlook
	Sharing a book exported to Outlook
	Deleting a book exported to Outlook

	Printed views and briefing books

	Communicating
	E-mail a briefing book

	Presenting
	Export to Excel
	Sharing a view exported to Excel
	Deleting a view exported to Excel

	Export to PowerPoint
	Sharing a book exported to PowerPoint
	Deleting a book exported to PowerPoint



	Chapter 7: Online Publishing
	ProClarity Server
	ProClarity Server components
	Showing the ProClarity Server publishing menu
	Publishing to ProClarity Server
	Retrieving a published briefing book
	Editing a published briefing book
	Managing published books
	Managing roles
	Granting reader access rights to roles
	The settings in the Access rights example diagram allow members of the Sales Representatives role...
	Setting publishing properties

	Publishing views to My Views

	Active Books
	Creating an Active Book
	Sharing an Active Book
	About licensing
	Reading an Active Book
	Opening an Active Book on an intranet server
	Opening an Active Book over the Internet

	Deleting an Active Book

	Export to Web Part
	Exporting the current briefing book to Web Part
	Sharing a Web Part
	Deleting a Web Part


	Chapter 8: Using ProClarity Desktop Client’s Advanced Features
	How do I?
	Applying a meaningful name to a group of members
	Creating a custom measure or member to expedite a query
	Creating a calculated measure
	Creating a calculated member

	Developing models for budgeting and forecasting
	Creating a local cube file to use ProClarity Desktop Client from a laptop
	Posing a query in English
	Customizing the ProClarity Desktop Client startup view
	Developing Visual Basic code from within ProClarity Desktop Client
	Writing a macro to consolidate a series of tasks
	Creating an add-in to customize ProClarity Desktop Client
	Developing a plug-in to extend functionality

	Glossary
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	V
	W
	Y
	Z


